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ii                  10775A: Administering Microsoft SQL Server 2012 Databases 

Information in this document, including URL and other Internet Web site references, is subject to change 
without notice. Unless otherwise noted, the example companies, organizations, products, domain names, 
e-mail addresses, logos, people, places, and events depicted herein are fictitious, and no association with 
any real company, organization, product, domain name, e-mail address, logo, person, place or event is 
intended or should be inferred. Complying with all applicable copyright laws is the responsibility of the 
user. Without limiting the rights under copyright, no part of this document may be reproduced, stored in 
or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, 
photocopying, recording, or otherwise), or for any purpose, without the express written permission of 
Microsoft Corporation. 

Microsoft may have patents, patent applications, trademarks, copyrights, or other intellectual property 
rights covering subject matter in this document. Except as expressly provided in any written license 
agreement from Microsoft, the furnishing of this document does not give you any license to these 
patents, trademarks, copyrights, or other intellectual property. 

The names of manufacturers, products, or URLs are provided for informational purposes only and 
Microsoft makes no representations and warranties, either expressed, implied, or statutory, regarding 
these manufacturers or the use of the products with any Microsoft technologies. The inclusion of a 
manufacturer or product does not imply endorsement of Microsoft of the manufacturer or product. Links 
may be provided to third party sites. Such sites are not under the control of Microsoft and Microsoft is not 
responsible for the contents of any linked site or any link contained in a linked site, or any changes or 
updates to such sites. Microsoft is not responsible for webcasting or any other form of transmission 
received from any linked site. Microsoft is providing these links to you only as a convenience, and the 
inclusion of any link does not imply endorsement of Microsoft of the site or the products contained 
therein. 

© 2012 Microsoft Corporation. All rights reserved. 

Microsoft and the trademarks listed at http://www.microsoft.com/about/legal/en/us/IntellectualProperty 
/Trademarks/EN-US.aspx are trademarks of the Microsoft group of companies. All other trademarks are 
property of their respective owners 
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MICROSOFT LICENSE TERMS 
OFFICIAL MICROSOFT LEARNING PRODUCTS  
MICROSOFT OFFICIAL COURSE Pre-Release and Final Release Versions 
               
 
These license terms are an agreement between Microsoft Corporation and you. Please read them. They apply to 
the Licensed Content named above, which includes the media on which you received it, if any.  These license 
terms also apply to any updates, supplements, internet based services and support services for the Licensed 
Content, unless other terms accompany those items. If so, those terms apply. 
 
BY DOWNLOADING OR USING THE LICENSED CONTENT, YOU ACCEPT THESE TERMS. IF YOU DO NOT ACCEPT 
THEM, DO NOT DOWNLOAD OR USE THE LICENSED CONTENT. 
 
If you comply with these license terms, you have the rights below. 
             
1. DEFINITIONS. 

 
a. “Authorized Learning Center” means a Microsoft Learning Competency Member, Microsoft IT Academy 

Program Member, or such other entity as Microsoft may designate from time to time.  
 
b. “Authorized Training Session” means the Microsoft-authorized instructor-led training class using only 

MOC Courses that are conducted by a MCT at or through an Authorized Learning Center. 
 
c. “Classroom Device” means one (1) dedicated, secure computer that you own or control that meets or 

exceeds the hardware level specified for the particular MOC Course located at your training facilities or 
primary business location.  

 
d. “End User” means an individual who is (i) duly enrolled for an Authorized Training Session or Private 

Training Session, (ii) an employee of a MPN Member, or (iii) a Microsoft full-time employee. 
 
e. “Licensed Content” means the MOC Course and any other content accompanying this agreement.  

Licensed Content may include (i) Trainer Content, (ii) sample code, and (iii) associated media.  
 
f. “Microsoft Certified Trainer” or “MCT” means an individual who is (i) engaged to teach a training session 

to End Users on behalf of an Authorized Learning Center or MPN Member, (ii) currently certified as a 
Microsoft Certified Trainer under the Microsoft Certification Program, and (iii) holds a Microsoft 
Certification in the technology that is the subject of the training session.  

 
g. “Microsoft IT Academy Member” means a current, active member of the Microsoft IT Academy 

Program. 
 
h. “Microsoft Learning Competency Member” means a Microsoft Partner Network Program Member in 

good standing that currently holds the Learning Competency status. 
 
i. “Microsoft Official Course” or “MOC Course” means the Official Microsoft Learning Product instructor-

led courseware that educates IT professionals or developers on Microsoft technologies. 
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j. “Microsoft Partner Network Member” or “MPN Member” means a silver or gold-level Microsoft Partner 

Network program member in good standing. 
 
k. “Personal Device” means one (1) device, workstation or other digital electronic device that you 

personally own or control that meets or exceeds the hardware level specified for the particular MOC 
Course.  

 
l. “Private Training Session” means the instructor-led training classes provided by MPN Members for 

corporate customers to teach a predefined learning objective.  These classes are not advertised or 
promoted to the general public and class attendance is restricted to individuals employed by or 
contracted by the corporate customer. 

 
m. “Trainer Content” means the trainer version of the MOC Course and additional content designated 

solely for trainers to use to teach a training session using a MOC Course. Trainer Content may include 
Microsoft PowerPoint presentations, instructor notes, lab setup guide, demonstration guides, beta 
feedback form and trainer preparation guide for the MOC Course.  To clarify, Trainer Content does not 
include virtual hard disks or virtual machines. 
 

2. INSTALLATION AND USE RIGHTS. The Licensed Content is licensed not sold.  The Licensed Content is 
licensed on a one copy per user basis, such that you must acquire a license for each individual that 
accesses or uses the Licensed Content.  

 
2.1 Below are four separate sets of installation and use rights.  Only one set of rights apply to you.   

 
a. If you are a Authorized Learning Center: 

i. If the Licensed Content is in digital format for each license you acquire you may either:  
1. install one (1) copy of the Licensed Content in the form provided to you on a dedicated, secure 

server located on your premises where the Authorized Training Session is held for access and 
use by one (1) End User attending the Authorized Training Session, or by one (1) MCT teaching 
the Authorized Training Session, or 

2. install one (1) copy of the Licensed Content in the form provided to you on one (1) Classroom 
Device for access and use by one (1) End User attending the Authorized Training Session, or by 
one (1) MCT teaching the Authorized Training Session.  

ii. You agree that: 
1. you will acquire a license for each End User and MCT that accesses the Licensed Content, 
2. each End User and MCT will be presented with a copy of this agreement and each individual 

will agree that their use of the Licensed Content will be subject to these license terms prior to 
their accessing the Licensed Content. Each individual will be required to denote their 
acceptance of the EULA in a manner that is enforceable under local law prior to their accessing 
the Licensed Content,  

3. for all Authorized Training Sessions, you will only use qualified MCTs who hold the applicable 
competency to teach the particular MOC Course that is the subject of the training session,  

4. you will not alter or remove any copyright or other protective notices contained in the 
Licensed Content, 
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5. you will remove and irretrievably delete all Licensed Content from all Classroom Devices and 

servers at the end of the Authorized Training Session, 
6. you will only provide access to the Licensed Content to End Users and MCTs, 
7. you will only provide access to the Trainer Content to MCTs, and  
8. any Licensed Content installed for use during a training session will be done in accordance 

with the applicable classroom set-up guide.  
 

b. If you are a MPN Member.   
i. If the Licensed Content is in digital format for each license you acquire you may either: 

1. install one (1) copy of the Licensed Content in the form provided to you on (A) one (1) 
Classroom Device, or (B) one (1) dedicated, secure server located at your premises where 
the training session is held for use by one (1) of your employees attending a training session 
provided by you, or by one (1) MCT that is teaching the training session, or 

2. install one (1) copy of the Licensed Content in the form provided to you on one (1) 
Classroom Device for use by one (1) End User attending a Private Training Session, or one (1) 
MCT that is teaching the Private Training Session. 

ii. You agree that:  
1. you will acquire a license for each End User and MCT that accesses the Licensed Content, 
2. each End User and MCT will be presented with a copy of this agreement and each individual 

will agree that their use of the Licensed Content will be subject to these license terms prior 
to their accessing the Licensed Content. Each individual will be required to denote their 
acceptance of the EULA in a manner that is enforceable under local law prior to their 
accessing the Licensed Content,  

3. for all training sessions, you will only use qualified MCTs who hold the applicable 
competency to teach the particular MOC Course that is the subject of the training session,  

4. you will not alter or remove any copyright or other protective notices contained in the 
Licensed Content, 

5. you will remove and irretrievably delete all Licensed Content from all Classroom Devices and 
servers at the end of each training session, 

6. you will only provide access to the Licensed Content to End Users and MCTs, 
7. you will only provide access to the Trainer Content to MCTs, and 
8. any Licensed Content installed for use during a training session will be done in accordance 

with the applicable classroom set-up guide. 
 

c. If you are an End User: 
You may use the Licensed Content solely for your personal training use.  If the Licensed Content is in 
digital format, for each license you acquire you may (i) install one (1) copy of the Licensed Content in 
the form provided to you on one (1) Personal Device and install another copy on another Personal 
Device as a backup copy, which may be used only to reinstall the Licensed Content; or (ii) print one (1) 
copy of the Licensed Content.  You may not install or use a copy of the Licensed Content on a device 
you do not own or control. 
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d. If you are a MCT. 

i. For each license you acquire, you may use the Licensed Content solely to prepare and deliver an 
Authorized Training Session or Private Training Session.  For each license you acquire, you may 
install and use one (1) copy of the Licensed Content in the form provided to you on one (1) Personal 
Device and install one (1) additional copy on another Personal Device as a backup copy, which may 
be used only to reinstall the Licensed Content. You may not install or use a copy of the Licensed 
Content on a device you do not own or control.  
 

ii. Use of Instructional Components in Trainer Content.  You may customize, in accordance with the 
most recent version of the MCT Agreement, those portions of the Trainer Content that are logically 
associated with instruction of a training session.  If you elect to exercise the foregoing rights, you 
agree:  (a) that any of these customizations will only be used for providing a training session, (b) any 
customizations will comply with the terms and conditions for Modified Training Sessions and 
Supplemental Materials in the most recent version of the MCT agreement and with this agreement.  
For clarity, any use of “customize” refers only to changing the order of slides and content, and/or 
not using all the slides or content, it does not mean changing or modifying any slide or content. 

 
2.2 Separation of Components. The Licensed Content components are licensed as a single unit and you 
may not separate the components and install them on different devices.  
 
2.3 Reproduction/Redistribution Licensed Content.  Except as expressly provided in the applicable 
installation and use rights above, you may not reproduce or distribute the Licensed Content or any portion 
thereof (including any permitted modifications) to any third parties without the express written permission 
of Microsoft. 

 
2.4 Third Party Programs. The Licensed Content may contain third party programs or services. These 
license terms will apply to your use of those third party programs or services, unless other terms accompany 
those programs and services. 

 
2.5 Additional Terms.  Some Licensed Content may contain components with additional terms, 
conditions, and licenses regarding its use. Any non-conflicting terms in those conditions and licenses also 
apply to that respective component and supplements the terms described in this Agreement.  

 
3. PRE-RELEASE VERSIONS.  If the Licensed Content is a pre-release (“beta”) version, in addition to the other 

provisions in this agreement, then these terms also apply:   
 

a. Pre-Release Licensed Content.  This Licensed Content is a pre-release version.  It may not contain the 
same information and/or work the way a final version of the Licensed Content will.  We may change it 
for the final version.  We also may not release a final version.  Microsoft is under no obligation to 
provide you with any further content, including the final release version of the Licensed Content.  

 
b. Feedback.  If you agree to give feedback about the Licensed Content to Microsoft, either directly or 

through its third party designee, you give to Microsoft without charge, the right to use, share and 
commercialize your feedback in any way and for any purpose.  You also give to third parties, without 
charge, any patent rights needed for their products, technologies and services to use or interface with 
any specific parts of a Microsoft software, Microsoft product, or service that includes the feedback.  You 
will not give feedback that is subject to a license that requires Microsoft to license its software, 
technologies, or products to third parties because we include your feedback in them.  These rights 
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survive this agreement.   

 
c. Term.  If you are an Authorized Training Center, MCT or MPN, you agree to cease using all copies of the 

beta version of the Licensed Content upon (i) the date which Microsoft informs you is the end date for 
using the beta version, or (ii) sixty (60) days after the commercial release of the Licensed Content, 
whichever is earliest (“beta term”).  Upon expiration or termination of the beta term, you will 
irretrievably delete and destroy all copies of same in the possession or under your control. 
 

4. INTERNET-BASED SERVICES.  Classroom Devices located at Authorized Learning Center’s physical location 
may contain virtual machines and virtual hard disks for use while attending an Authorized Training 
Session.  You may only use the software on the virtual machines and virtual hard disks on a Classroom 
Device solely to perform the virtual lab activities included in the MOC Course while attending the 
Authorized Training Session. Microsoft may provide Internet-based services with the software included 
with the virtual machines and virtual hard disks.  It may change or cancel them at any time.  If the 
software is pre-release versions of software, some of its Internet-based services may be turned on by 
default.  The default setting in these versions of the software do not necessarily reflect how the features 
will be configured in the commercially released versions.  If Internet-based services are included with the 
software, they are typically simulated for demonstration purposes in the software and no transmission 
over the Internet takes place.  However, should the software be configured to transmit over the Internet, 
the following terms apply:  

a. Consent for Internet-Based Services. The software features described below connect to Microsoft or 
service provider computer systems over the Internet. In some cases, you will not receive a separate 
notice when they connect. You may switch off these features or not use them. By using these features, 
you consent to the transmission of this information. Microsoft does not use the information to identify 
or contact you. 

b. Computer Information. The following features use Internet protocols, which send to the appropriate 
systems computer information, such as your Internet protocol address, the type of operating system, 
browser and name and version of the software you are using, and the language code of the device 
where you installed the software. Microsoft uses this information to make the Internet-based services 
available to you. 

• Accelerators. When you use click on or move your mouse over an Accelerator, the title and full web 
address or URL of the current webpage, as well as standard computer information, and any content 
you have selected, might be sent to the service provider. If you use an Accelerator provided by 
Microsoft, the information sent is subject to the Microsoft Online Privacy Statement, which is 
available at go.microsoft.com/fwlink/?linkid=31493. If you use an Accelerator provided by a third 
party, use of the information sent will be subject to the third party’s privacy practices. 

• Automatic Updates. This software contains an Automatic Update feature that is on by default. For 
more information about this feature, including instructions for turning it off, see 
go.microsoft.com/fwlink/?LinkId=178857. You may turn off this feature while the software is 
running (“opt out”). Unless you expressly opt out of this feature, this feature will (a) connect to 
Microsoft or service provider computer systems over the Internet, (b) use Internet protocols to send 
to the appropriate systems standard computer information, such as your computer’s Internet 
protocol address, the type of operating system, browser and name and version of the software you 
are using, and the language code of the device where you installed the software, and (c) 
automatically download and install, or prompt you to download and/or install, current Updates to 
the software. In some cases, you will not receive a separate notice before this feature takes effect. 
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By installing the software, you consent to the transmission of standard computer information and 
the automatic downloading and installation of updates.  

• Auto Root Update. The Auto Root Update feature updates the list of trusted certificate authorities. 
you can switch off the Auto Root Update feature. 

• Customer Experience Improvement Program (CEIP), Error and Usage Reporting; Error Reports. This 
software uses CEIP and Error and Usage Reporting components enabled by default that 
automatically send to Microsoft information about your hardware and how you use this software. 
This software also automatically sends error reports to Microsoft that describe which software 
components had errors and may also include memory dumps. You may choose not to use these 
software components. For more information please go to 
<http://go.microsoft.com/fwlink/?LinkID=196910>. 

• Digital Certificates. The software uses digital certificates. These digital certificates confirm the 
identity of Internet users sending X.509 standard encrypted information. They also can be used to 
digitally sign files and macros, to verify the integrity and origin of the file contents. The software 
retrieves certificates and updates certificate revocation lists. These security features operate only 
when you use the Internet. 

• Extension Manager.  The Extension Manager can retrieve other software through the internet from 
the Visual Studio Gallery website.  To provide this other software, the Extension Manager sends to 
Microsoft the name and version of the software you are using and language code of the device 
where you installed the software.   This other software is provided by third parties to Visual Studio 
Gallery.  It is licensed to users under terms provided by the third parties, not from Microsoft. Read 
the Visual Studio Gallery terms of use for more information. 

• IPv6 Network Address Translation (NAT) Traversal service (Teredo). This feature helps existing 
home Internet gateway devices transition to IPv6. IPv6 is a next generation Internet protocol. It 
helps enable end-to-end connectivity often needed by peer-to-peer applications. To do so, each 
time you start up the software the Teredo client service will attempt to locate a public Teredo 
Internet service. It does so by sending a query over the Internet. This query only transfers standard 
Domain Name Service information to determine if your computer is connected to the Internet and 
can locate a public Teredo service. If you 

· use an application that needs IPv6 connectivity or 
· configure your firewall to always enable IPv6 connectivity 

 
by default standard Internet Protocol information will be sent to the Teredo service at Microsoft at 
regular intervals. No other information is sent to Microsoft. You can change this default to use non-
Microsoft servers. You can also switch off this feature using a command line utility named “netsh”. 

• Malicious Software Removal. During setup, if you select “Get important updates for installation”, 
the software may check and remove certain malware from your device. “Malware” is malicious 
software. If the software runs, it will remove the Malware listed and updated at 
www.support.microsoft.com/?kbid=890830. During a Malware check, a report will be sent to 
Microsoft with specific information about Malware detected, errors, and other information about 
your device. This information is used to improve the software and other Microsoft products and 
services. No information included in these reports will be used to identify or contact you. You may 
disable the software’s reporting functionality by following the instructions found at 
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www.support.microsoft.com/?kbid=890830. For more information, read the Windows Malicious 
Software Removal Tool privacy statement at go.microsoft.com/fwlink/?LinkId=113995. 

• Microsoft Digital Rights Management. If you use the software to access content that has been 
protected with Microsoft Digital Rights Management (DRM), then, in order to let you play the 
content, the software may automatically request media usage rights from a rights server on the 
Internet and download and install available DRM updates. For more information, see 
go.microsoft.com/fwlink/?LinkId=178857.  

• Microsoft Telemetry Reporting Participation.  If you choose to participate in Microsoft Telemetry 
Reporting through a “basic” or “advanced” membership, information regarding filtered URLs, 
malware and other attacks on your network is sent to Microsoft.  This information helps Microsoft 
improve the ability of Forefront Threat Management Gateway to identify attack patterns and 
mitigate threats. In some cases, personal information may be inadvertently sent, but Microsoft will 
not use the information to identify or contact you.  You can switch off Telemetry Reporting. For 
more information on this feature, see http://go.microsoft.com/fwlink/?LinkId=130980.  

• Microsoft Update Feature. To help keep the software up-to-date, from time to time, the software 
connects to Microsoft or service provider computer systems over the Internet.  In some cases, you 
will not receive a separate notice when they connect.  When the software does so, we check your 
version of the software and recommend or download updates to your devices.  You may not receive 
notice when we download the update.  You may switch off this feature. 

• Network Awareness. This feature determines whether a system is connected to a network by either 
passive monitoring of network traffic or active DNS or HTTP queries. The query only transfers 
standard TCP/IP or DNS information for routing purposes. You can switch off the active query 
feature through a registry setting. 

• Plug and Play and Plug and Play Extensions. You may connect new hardware to your device, either 
directly or over a network. Your device may not have the drivers needed to communicate with that 
hardware. If so, the update feature of the software can obtain the correct driver from Microsoft and 
install it on your device. An administrator can disable this update feature. 

• Real Simple Syndication (“RSS”) Feed.  This software start page contains updated content that is 
supplied by means of an RSS feed online from Microsoft. 

• Search Suggestions Service. When you type a search query in Internet Explorer by using the Instant 
Search box or by typing a question mark (?) before your search term in the Address bar, you will see 
search suggestions as you type (if supported by your search provider). Everything you type in the 
Instant Search box or in the Address bar when preceded by a question mark (?) is sent to your 
search provider as you type it. In addition, when you press Enter or click the Search button, all the 
text that is in the search box or Address bar is sent to the search provider. If you use a Microsoft 
search provider, the information you send is subject to the Microsoft Online Privacy Statement, 
which is available at go.microsoft.com/fwlink/?linkid=31493. If you use a third-party search 
provider, use of the information sent will be subject to the third party’s privacy practices. You can 
turn search suggestions off at any time in Internet Explorer by using Manage Add-ons under the 
Tools button. For more information about the search suggestions service, see 
go.microsoft.com/fwlink/?linkid=128106.  

• SQL Server Reporting Services Map Report Item. The software may include features that retrieve 
content such as maps, images and other data through the Bing Maps (or successor branded) 
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application programming interface (the “Bing Maps APIs”). The purpose of these features is to 
create reports displaying data on top of maps, aerial and hybrid imagery. If these features are 
included, you may use them to create and view dynamic or static documents. This may be done only 
in conjunction with and through methods and means of access integrated in the software. You may 
not otherwise copy, store, archive, or create a database of the content available through the Bing 
Maps APIs. you may not use the following for any purpose even if they are available through the 
Bing Maps APIs: 

• Bing Maps APIs to provide sensor based guidance/routing, or 

• Any Road Traffic Data or Bird’s Eye Imagery (or associated metadata). 

Your use of the Bing Maps APIs and associated content is also subject to the additional terms and 
conditions at http://www.microsoft.com/maps/product/terms.html. 

• URL Filtering. The URL Filtering feature identifies certain types of web sites based upon predefined 
URL categories, and allows you to deny access to such web sites, such as known malicious sites and 
sites displaying inappropriate or pornographic materials. To apply URL filtering, Microsoft queries 
the online Microsoft Reputation Service for URL categorization.  You can switch off URL filtering. For 
more information on this feature, see http://go.microsoft.com/fwlink/?LinkId=130980 

• Web Content Features. Features in the software can retrieve related content from Microsoft and 
provide it to you. To provide the content, these features send to Microsoft the type of operating 
system, name and version of the software you are using, type of browser and language code of the 
device where you run the software. Examples of these features are clip art, templates, online 
training, online assistance and Appshelp. You may choose not to use these web content features. 

• Windows Media Digital Rights Management. Content owners use Windows Media digital rights 
management technology (WMDRM) to protect their intellectual property, including copyrights. This 
software and third party software use WMDRM to play and copy WMDRM-protected content. If the 
software fails to protect the content, content owners may ask Microsoft to revoke the software’s 
ability to use WMDRM to play or copy protected content. Revocation does not affect other content. 
When you download licenses for protected content, you agree that Microsoft may include a 
revocation list with the licenses. Content owners may require you to upgrade WMDRM to access 
their content. Microsoft software that includes WMDRM will ask for your consent prior to the 
upgrade. If you decline an upgrade, you will not be able to access content that requires the upgrade. 
You may switch off WMDRM features that access the Internet. When these features are off, you can 
still play content for which you have a valid license.  

• Windows Media Player. When you use Windows Media Player, it checks with Microsoft for 

· compatible online music services in your region; 
· new versions of the player; and 
· codecs if your device does not have the correct ones for playing content. 
 

You can switch off this last feature. For more information, go to 
www.microsoft.com/windows/windowsmedia/player/11/privacy.aspx. 

• Windows Rights Management Services. The software contains a feature that allows you to create 
content that cannot be printed, copied or sent to others without your permission. For more 
information, go to www.microsoft.com/rms. you may choose not to use this feature 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
• Windows Time Service. This service synchronizes with time.windows.com once a week to provide 

your computer with the correct time. You can turn this feature off or choose your preferred time 
source within the Date and Time Control Panel applet. The connection uses standard NTP protocol. 

• Windows Update Feature. You may connect new hardware to the device where you run the 
software. Your device may not have the drivers needed to communicate with that hardware. If so, 
the update feature of the software can obtain the correct driver from Microsoft and run it on your 
device. You can switch off this update feature. 

c. Use of Information.  Microsoft may use the device information, error reports, and malware reports to 
improve our software and services. We may also share it with others, such as hardware and software 
vendors. They may use the information to improve how their products run with Microsoft software. 

d. Misuse of Internet-based Services. You may not use any Internet-based service in any way that could 
harm it or impair anyone else’s use of it. You may not use the service to try to gain unauthorized access 
to any service, data, account or network by any means.  
 

5. SCOPE OF LICENSE. The Licensed Content is licensed, not sold. This agreement only gives you some rights 
to use the Licensed Content. Microsoft reserves all other rights. Unless applicable law gives you more 
rights despite this limitation, you may use the Licensed Content only as expressly permitted in this 
agreement. In doing so, you must comply with any technical limitations in the Licensed Content that only 
allows you to use it in certain ways. Except as expressly permitted in this agreement, you may not: 
• install more copies of the Licensed Content on devices than the number of licenses you acquired;  
• allow more individuals to access the Licensed Content than the number of licenses you acquired; 
• publicly display, or make the Licensed Content available for others to access or use;  
• install, sell, publish, transmit, encumber, pledge, lend, copy, adapt, link to, post, rent, lease or lend, 

make available or distribute the Licensed Content to any third party, except as expressly permitted 
by this Agreement. 

• reverse engineer, decompile, remove or otherwise thwart any protections or disassemble the 
Licensed Content except and only to the extent that applicable law expressly permits, despite this 
limitation;  

• access or use any Licensed Content for which you  are not providing a training session to End Users 
using the Licensed Content; 

• access or use any Licensed Content that you have not been authorized by Microsoft to access and 
use; or 

• transfer the Licensed Content, in whole or in part, or assign this agreement to any third party. 
 

6. RESERVATION OF RIGHTS AND OWNERSHIP.  Microsoft reserves all rights not expressly granted to you in 
this agreement.  The Licensed Content is protected by copyright and other intellectual property laws and 
treaties.  Microsoft or its suppliers own the title, copyright, and other intellectual property rights in the 
Licensed Content.  You may not remove or obscure any copyright, trademark or patent notices that 
appear on the Licensed Content or any components thereof, as delivered to you.   
 

7. EXPORT RESTRICTIONS. The Licensed Content is subject to United States export laws and regulations. You 
must comply with all domestic and international export laws and regulations that apply to the Licensed 
Content. These laws include restrictions on destinations, End Users and end use. For additional 
information, see www.microsoft.com/exporting. 
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8. LIMITATIONS ON SALE, RENTAL, ETC. AND CERTAIN ASSIGNMENTS. You may not sell, rent, lease, lend or 

sublicense the Licensed Content or any portion thereof, or transfer or assign this agreement.   
 

9. SUPPORT SERVICES. Because the Licensed Content is “as is”, we may not provide support services for it. 
 

10. TERMINATION. Without prejudice to any other rights, Microsoft may terminate this agreement if you fail 
to comply with the terms and conditions of this agreement. Upon any termination of this agreement, you 
agree to immediately stop all use of and to irretrievable delete and destroy all copies of the Licensed 
Content in your possession or under your control.  

 
11. LINKS TO THIRD PARTY SITES.  You may link to third party sites through the use of the Licensed Content.  

The third party sites are not under the control of Microsoft, and Microsoft is not responsible for the 
contents of any third party sites, any links contained in third party sites, or any changes or updates to third 
party sites.  Microsoft is not responsible for webcasting or any other form of transmission received from 
any third party sites.  Microsoft is providing these links to third party sites to you only as a convenience, 
and the inclusion of any link does not imply an endorsement by Microsoft of the third party site. 

 
12. ENTIRE AGREEMENT. This agreement, and the terms for supplements, updates and support services are 

the entire agreement for the Licensed Content.  
 
13. APPLICABLE LAW.  

a. United States. If you acquired the Licensed Content in the United States, Washington state law governs 
the interpretation of this agreement and applies to claims for breach of it, regardless of conflict of laws 
principles. The laws of the state where you live govern all other claims, including claims under state 
consumer protection laws, unfair competition laws, and in tort.  
 

b. Outside the United States. If you acquired the Licensed Content in any other country, the laws of that 
country apply.  
 

14. LEGAL EFFECT. This agreement describes certain legal rights. You may have other rights under the laws of 
your country. You may also have rights with respect to the party from whom you acquired the Licensed 
Content. This agreement does not change your rights under the laws of your country if the laws of your 
country do not permit it to do so.  

 
15. DISCLAIMER OF WARRANTY. THE LICENSED CONTENT IS LICENSED "AS-IS," "WITH ALL FAULTS," AND "AS 

AVAILABLE." YOU BEAR THE RISK OF USING IT. MICROSOFT CORPORATION AND ITS RESPECTIVE 
AFFILIATES GIVE NO EXPRESS WARRANTIES, GUARANTEES, OR CONDITIONS UNDER OR IN RELATION TO 
THE LICENSED CONTENT. YOU MAY HAVE ADDITIONAL CONSUMER RIGHTS UNDER YOUR LOCAL LAWS 
WHICH THIS AGREEMENT CANNOT CHANGE. TO THE EXTENT PERMITTED UNDER YOUR LOCAL LAWS, 
MICROSOFT CORPORATION AND ITS RESPECTIVE AFFILIATES EXCLUDE ANY IMPLIED WARRANTIES OR 
CONDITIONS, INCLUDING THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NON-INFRINGEMENT. 

 
16. LIMITATION ON AND EXCLUSION OF REMEDIES AND DAMAGES. TO THE EXTENT NOT PROHIBITED BY 

LAW, YOU CAN RECOVER FROM MICROSOFT CORPORATION AND ITS SUPPLIERS ONLY DIRECT 
DAMAGES UP TO USD$5.00. YOU AGREE NOT TO SEEK TO RECOVER ANY OTHER DAMAGES, INCLUDING 
CONSEQUENTIAL, LOST PROFITS, SPECIAL, INDIRECT OR INCIDENTAL DAMAGES FROM MICROSOFT 
CORPORATION AND ITS RESPECTIVE SUPPLIERS. 
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This limitation applies to 
o anything related to the Licensed Content, services made available through the Licensed Content, or 

content (including code) on third party Internet sites or third-party programs; and  
o claims for breach of contract, breach of warranty, guarantee or condition, strict liability, negligence, 

or other tort to the extent permitted by applicable law.  
 

It also applies even if Microsoft knew or should have known about the possibility of the damages. The 
above limitation or exclusion may not apply to you because your country may not allow the exclusion or 
limitation of incidental, consequential or other damages.  

 
Please note: As this Licensed Content is distributed in Quebec, Canada, some of the clauses in this agreement 
are provided below in French. 
 
Remarque : Ce le contenu sous licence étant distribué au Québec, Canada, certaines des clauses dans ce 
contrat sont fournies ci-dessous en français. 
 
EXONÉRATION DE GARANTIE. Le contenu sous licence visé par une licence est offert « tel quel ». Toute 
utilisation de ce contenu sous licence est à votre seule risque et péril. Microsoft n’accorde aucune autre garantie 
expresse. Vous pouvez bénéficier de droits additionnels en vertu du droit local sur la protection dues 
consommateurs, que ce contrat ne peut modifier. La ou elles sont permises par le droit locale, les garanties 
implicites de qualité marchande, d’adéquation à un usage particulier et d’absence de contrefaçon sont exclues. 
 
LIMITATION DES DOMMAGES-INTÉRÊTS ET EXCLUSION DE RESPONSABILITÉ POUR LES DOMMAGES.  Vous 
pouvez obtenir de Microsoft et de ses fournisseurs une indemnisation en cas de dommages directs uniquement 
à hauteur de 5,00 $ US. Vous ne pouvez prétendre à aucune indemnisation pour les autres dommages, y 
compris les dommages spéciaux, indirects ou accessoires et pertes de bénéfices. 
Cette limitation concerne: 

• tout  ce qui est relié au le contenu sous licence , aux services ou au contenu (y compris le code) 
figurant sur des sites Internet tiers ou dans des programmes tiers ; et 

• les réclamations au titre de violation de contrat ou de garantie, ou au titre de responsabilité 
stricte, de négligence ou d’une autre faute dans la limite autorisée par la loi en vigueur. 

 
Elle s’applique également, même si Microsoft connaissait ou devrait connaître l’éventualité d’un tel dommage.  
Si votre pays n’autorise pas l’exclusion ou la limitation de responsabilité pour les dommages indirects, 
accessoires ou de quelque nature que ce soit, il se peut que la limitation ou l’exclusion ci-dessus ne s’appliquera 
pas à votre égard. 
 
EFFET JURIDIQUE.  Le présent contrat décrit certains droits juridiques. Vous pourriez avoir d’autres droits prévus 
par les lois de votre pays.  Le présent contrat ne modifie pas les droits que vous confèrent les lois de votre pays 
si celles-ci ne le permettent pas. 
 
Revised March 2012 
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Tracing Access to SQL Server 2012 
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SQL Trace  

SQL Server Profiler is a graphical tool and it is important to realize that it can have significant performance 
impacts on the server being traced, depending upon the options chosen. SQL Trace is a library of system 
stored procedures that can be used for tracing when minimizing the performance impacts of the tracing is 
necessary. Internally, SQL Server Profiler uses the programming interface that has been provided by SQL 
Trace. 

Note The Extended Events system that was introduced in SQL Server 2008 also provides 
capabilities for tracing SQL Server activity and resources. The use of Extended Events for 
tracing activity is discussed later in this lesson. The use of Extended Events for other 
monitoring purposes is outside the scope of this course. 

Question: Where would the ability to replay a trace be useful? 
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Capturing to Tables 

SQL Server Profiler can also capture trace data to database tables. The underlying SQL Trace 
programming interface does not directly support output to tables. This means that the SQL Server Profiler 
program needs to retrieve the event data into its graphical grid and as batches of rows are received, SQL 
Server Profiler then writes those rows to the selected database table. 

Note It is very important to avoid writing trace data directly back to the SQL Server 
system that is being monitored, unless a very low level of activity is expected. 

SQL Server Profiler also provides an option for saving existing captured event data that is being displayed 
in the graphical grid into a database table. 

Question: What might be an advantage of saving events in a SQL Server table? 
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(continued) 

Event Description

RPC: Completed The RPC:Completed event is fired when a stored procedure finishes 
execution. There is a traceable event when the stored procedure 
starts but similar to the SQL:BatchCompleted event, the 
RPC:Completed event is useful as it contains details of the resources 
used during the execution of the stored procedure. You can see a 
statement by statement breakdown of resources used within the 
stored procedure via the SP:StmtCompleted event. 

Audit Login / Audit 
Logout 

You can include in your traces details of each login and logout 
event that occurs during the tracing activity. 

Deadlock Graph Unhandled deadlocks often lead to errors being passed to end users 
from applications. If your system is suffering from deadlocks, the 
Deadlock Graph event fires when deadlocks occur and captures 
details of what caused the deadlock. The details are captured into 
an XML document that can be viewed graphically within SQL Server 
Profiler. 

 

Question: Why would events that are raised on completion of batches or statements often 
be more interesting than events that are raised when batches or statements start? 
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Useful Columns Often Omitted 

One of the more interesting columns is the TextData column. Many events do not include it by default yet 
the values contained in it are very useful. For example, in the RPC:Completed event, the TextData column 
contains the T-SQL statement that was used to execute the stored procedure. 

Two other useful columns are the database ID and the database name. You will often need to create a 
filter based on the database that you want to trace activity against. Tracing by database ID is more 
efficient than tracing by database name. However, trace templates that filter by database ID are less 
portable than those that filter by database name because a database that is restored on another server 
will typically have a different database ID. You can also use wildcard values within the LIKE clause of a 
database name filter. 

Question: What information would the TextData column return? 
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17-20 Tracing Access to SQL Server 2012 

(continued) 

Tool Description & Location 

SQL Server Data Collection Automated system for collecting and storing 
performance data along with a set of standard reports. 
Data collection is discussed in Module 18. 

SQL Server Profiler Tracing and profiling tool that was discussed in the first 
lesson in this module. 

SQL Trace Programming interface for tracing SQL Server access 
that is discussed in the last lesson in this module. 

SQL Server Extended Events Light-weight eventing architecture. You have seen how 
to use Extended Events Profiler to capture server activity. 
Working directly with Extended Events (not via a GUI 
interface) is out of scope for this training. 

Distributed Relay Advanced tool for replaying workloads across a 
potentially distributed set of servers. Distributed Relay is 
out of scope for this training. 

Reliability and Performance 
Monitor 

Standard Windows performance tool that is discussed in 
Module 18. 

 

Question: Which tools might be useful for real time monitoring? 
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17-22 Tracing Access to SQL Server 2012 

Recommendations 

The recommendations that can be produced include suggested changes to the database such as new 
indexes, indexes that should be dropped, and depending on the tuning options you set, partitioning 
recommendations. The recommendations that are produced are provided as a set of Transact-SQL 
statements that would implement the suggested changes. You can view the Transact-SQL and save it for 
later review and application, or you can choose to implement the recommended changes immediately. 

Be careful of applying changes to a database without detailed consideration, especially in production 
environments. Also, ensure that any analysis that you perform is based on appropriately sized workloads 
so that recommendations are not made based on partial information. 

Question: Why is it important to tune an entire workload rather than individual queries? 
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Traces do not automatically restart after the server instance restarts. If a trace needs to be run constantly, 
the trace needs to be scripted, launched from within a stored procedure, and the stored procedure 
marked as a startup procedure. 

Question: Which option would have less impact on a traced system? 

 a) SQL Trace with output to a file   

 b) SQL Profiler with output to a table  
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(continued) 

Object Events

Security Audit Audit Add DB user event 

Audit Add login to server role event  

Audit Add Member to DB role event  

Audit Add Role event  

Audit Add login event  

Audit Backup/Restore event  

Audit Change Database owner  

Audit DBCC event  

Audit Database Scope GDR event  

Audit Login Change Property event  

Audit Login Failed  

Audit Login GDR event  

Audit Schema Object GDR event  

Audit Schema Object Take Ownership  

Audit Server Starts and Stops  

Server Server Memory Change 

 

The default trace can be enabled or disabled using sp_configure. In the example shown in the slide, you 
can see how to re-enable the default trace if necessary. 

The default trace cannot be modified and also the file location cannot be changed.  

Question: Should the default trace be kept enabled? 
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Exercise 1: Capture a Trace Using SQL Server Profiler 

Scenario 

You have isolated the workload that causes the poor performance and you want to test the queries in a 
development environment. In this exercise, you will generate sample workload and you will capture 
database activity using SQL Server Profiler. 

The main tasks for this exercise are as follows: 

1. Create and start a suitable SQL Server Profiler trace. 

2. Execute the workload. 

3. Stop the trace. 

 Task 1: Create and start a suitable SQL Server Profiler trace 
• Create a SQL Server Profiler trace based upon the following settings: 

• Tuning template 

• Filtered to the MarketDev database only 

• Rollover files disabled 

• Maximum trace file size is 500 MB 

• Start the trace. 

 Task 2: Execute the workload 
• Open and execute the file 51 – Lab Exercise 1.sql which is a workload file to be analyzed. 

Note Ensure that you configure the workload window as per the instructions at the top of 
the script. 

 Task 3: Stop the trace 
• When the query completes, stop the trace. 

• Close SQL Server Profiler. 

Results: After this exercise, you should have captured a workload using SQL Server Profiler.  

Exercise 2: Analyze a Trace Using Database Engine Tuning Advisor 

Scenario 

You want to take the results captured from the SQL Trace and identify any changes that could be made to 
improve performance. In this exercise you will analyze captured activity using the Database Engine Tuning 
Advisor. 

The main tasks for this exercise are as follows: 

1. Analyze the captured trace in Database Engine Tuning Advisor. 

2. Review the suggested modifications. 
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 Task 1: Analyze the captured trace in Database Engine Tuning Advisor 
• Analyze the captured trace file using Database Engine Tuning Advisor. 

 Task 2: Review the suggested modifications 
• Review the suggested modifications. 

• Close Database Engine Tuning Advisor. 

Results: After this exercise, you should have analyzed the trace using Database 
Engine Tuning Advisor and reviewed the suggested modifications. 

Challenge Exercise 3: Configure SQL Trace (Only if time permits) 

Scenario 

You have noticed that when SQL Profiler is running on the production server that performance is reduced. 
You want to capture the performance metrics and reduce the impact on the server. In this exercise, you 
will capture activity using the SQL Trace stored procedures to show how this can be used instead of SQL 
Profiler, to lessen the impact on the server. 

The main tasks for this exercise are as follows: 

1. Create a script that uses SQL Trace procedures to implement the same type of capture as you 
performed in Exercise 1 but with a different trace name. 

2. Test that the script works as expected by using the same workload. 

3. Analyze the new captured output and note if the suggested changes are identical to those suggested 
in Exercise 2. 

 Task 1: Create a script that uses SQL Trace procedures to implement the same type of 
capture as you performed in Exercise 1 but with a different trace name 
• Create, start, and stop the same trace that you used in Exercise 1 but call the trace ProsewareTrace2. 

• Export the trace definition to a file. 

 Task 2: Test that the script works as expected by using the same workload 
• Configure and start the saved trace definition file. Make sure that you note the trace ID. 

• Re-execute the 51 – Lab Exercise 1.sql workload file. 

 Task 3: Analyze the new captured output and note if the suggested changes are 
identical to those suggested in Exercise 2 
• Stop the trace. 

• Open and review the captured trace file. 

Results: After this exercise, you should have captured a trace using SQL Trace. 
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Module 18 
Monitoring SQL Server 2012  

Contents: 
Lesson 1: Monitoring Activity 18-3 

Lesson 2: Capturing and Managing Performance Data 18-15 

Lesson 3: Analyzing Collected Performance Data 18-23 

Lab 18: Monitoring SQL Server 2012 18-32 
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All dynamic management views and functions exist in the sys schema and follow the naming convention 
dm_%. They are defined in the hidden resource database and are mapped to the other databases. The 
DMVs and DMFs are organized into a set of categories: 

Category Description 

sys.dm_exec_% These objects provide information about connections, 
sessions, requests, and query execution. For example, 
sys.dm_exec_sessions provides one row for every session that 
is currently connected to the server. 

sys.dm_os_% These objects provide access to SQL OS related information. 
For example, sys.dm_os_performance_counters provides 
access to SQL Server performance counters without the need 
to access them using operating system tools. 

sys.dm_tran_% These objects provide access to transaction management. For 
example, sys.dm_os_tran_active_transactions provides details 
of currently active transactions. 

sys.dm_io_% These objects provide information on I/O processes. For 
example, sys.dm_io_virtual_file_stats provides details of I/O 
performance and statistics for each database file. 

sys.dm_db_% These objects provide database-scoped information. For 
example, sys.dm_db_index_usage_stats provides information 
about how each index in the database has been used. 

 

Required Permissions 
To query a DMV or DMF requires SELECT permission on the object and VIEW SERVER STATE or VIEW 
DATABASE STATE permission, depending upon whether the object is server-scoped or database-scoped. 
This lets you selectively restrict access of a user or login to dynamic management views and functions. To 
control access for a user, first create the user in master (with any user name) and then deny the user 
SELECT permission on the DMVs or DMFs that you do not want them to access. After this, the user cannot 
select from these DMVs and DMFs, regardless of database context of the user because the DENY within 
that database context is processed first. 

Question: Why would you want to use dynamic management views to view current activity? 
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In many cases, when a task is waiting, the cause of the wait will be some form of lock. Locks are discussed 
further in Module 20. 

Objects That Return Historical Information 

The second type of dynamic management object returns historical information. For example, you saw that 
the sys.dm_os_waiting_tasks view returned details of tasks that are currently waiting on resources. By 
comparison, the sys.dm_os_wait_stats view returns information about how often and how long any task 
had to wait for a specific wait_type since the SQL Server instance started.  

Another useful example of a historical function is the sys.dm_io_virtual_file_stats() function that returns 
information about the performance of database files. 

Question: What types of resources might SQL Server need to wait for? 
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SQL Server also provides the same counter values through the sys.dm_os_performance_counters dynamic 
management view. 

Question: Why might it be useful to query sys.dm_os_performance_counters to access SQL 
Server counters rather than using Performance Monitor? 
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Management Data Warehouse and Reports 

The data that is collected by the SQL Server Data Collector is stored in a central repository called a 
management data warehouse. The management data warehouse is a SQL Server database that is created 
by a wizard that is also used to configure data collection.  

Three standard reports and a rich set of sub-reports has been provided with the Data Collector but it is 
possible to write your own reports that are based on either the data that is collected by the System Data 
Collection Sets or data that is collected by user-defined Data Collection Sets. 

Question: Can Data Collector be used for real time monitoring? 
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The overview page for the Management Data Warehouse reports provides links to the main report areas 
as shown in the following screenshot: 

 

 

 

 

 

 

 

From this overview page, there are three main report areas that are linked: 

• Disk Usage Summary 

• Query Statistics History 

• Server Activity History 

Note Each report can be printed and exported to PDF or Microsoft Excel® files for further 
analysis. 

Question: What period would the Data Collector reports cover? 

  



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
18-26 Mon

D

K

Th
se

N
Sy
th
w

Th
th

 

itoring SQL Server 20

Disk Usage

Key Points 

he disk usage 
et gathers disk

ote that by de
ystem Data Co
his should not 

warrants the us

his report also
he usage data. 

Question: 
data? 

012 

e Report 

reports are ba
k usage data ev

efault, the Disk
ollection Sets. H
be a concern 
e of this longe

includes a nu

What might b

ased on the Dis
very six hours 

k Usage System
However, as th
and the value 

er retention pe

mber of hyper

e a good custo

 

sk Usage Syste
and keeps the

m Collection Se
he amount of d
of being able 

eriod. 

rlinks that lead

om report tha

em Data Collec
e data for two 

et retains data
data collected
to track indivi

d to a set of lin

t could be cre

ction Set. By d
years. 

a for much lon
 by this collect
idual file space

nked sub-repo

eated based on

 

default, the col

ger than othe
tion set is quit
e usage over t

orts for drilling

n disk usage 

 

lection 

r 
te small, 
ime 

 into 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
D

D

1.

2.

3.

 

Demonstra

Demonstrati

. If Demonst

• Revert 

• In the v
SQL Se
Conne
D:\107

• From t
from w

• Open a

. Open the 3

. Follow the 

 

ation 3A: V

ion Steps 

ration 1A was 

the virtual ma

virtual machi
erver Manage
ect. From the F
775A_Labs\10

he View menu
within Solution 

and follow the

31 – Demonst

instructions co

Viewing th

not performe

achines as per 

ne, click Start
ement Studio.
File menu, clic
0775A_18_PRJ

u, click Solutio
Explorer. 

e instructions in

ration 3A.sql

ontained withi

 

e Disk Usa

d: 

the instruction

t, click All Prog
. In the Conne
k Open, click P
J\10775A_18_

on Explorer. O

n the 21 – Dem

script file. 

n the commen

10775A: Administer

age Report

ns in D:\10775

grams, click M
ect to Server w
Project/Solut
_PRJ.ssmssln

Open and exec

monstration 2

nts of the scrip

ring Microsoft SQL Se

t 

5A_Labs\Revert

Microsoft SQL
window, type 
tion, navigate 
and click Ope

cute the 00 – S

2A.sql script f

pt file. 

erver 2012 Database

 

t.txt. 

L Server 2012,
Proseware an
to 

en. 

Setup.sql scrip

file. 

es  18-27 

, click 
nd click 

pt file 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
18-28 Mon

S

K

Th
ga
ac
co
th
m

Th
p
in
ex

 

itoring SQL Server 20

erver Activ

Key Points 

he Server Activ
athers a lot of 
ccessed using 
ounters to retr
hat are running

minutes by defa

his report has 
rovided on the

nvestigate this 
xample, you ca

Question: 
processes r

012 

vity Repor

vity Report is b
SQL Server re
DMVs. In addi

rieve informati
g on the system
ault. The histo

a large numbe
e initial summa
report, you wi
an click on a tr

Why is it impo
unning on the

rt 

based on the S
lated statistics
ition, the colle
on such as CP
m. The collecti
ry is retained f

er of linked su
ary. The initial 
ill find that alm
rend line in a g

ortant that dat
e system? 

 

Server Activity 
s such as waits,
ction set gath

PU and memor
ion runs every
for fourteen da

b-reports that
report is a da

most every item
graph to find o

a collection al

System Data C
, locks, latches
ers Windows a
ry usage from 
y sixty seconds
ays by default

t provide much
shboard that p
m displayed is 
out the values

so tracks the m

Collection Set.
s, and memory
and SQL Serve
the system an
 and is upload
. 

h deeper infor
provides an ov
a possible dri
 that make up

memory usage

 

. The collection
y statistics that
er Performance
nd from the pro
ded every fiftee

rmation than is
verview. If you
ll-through poi

p the trend. 

e of other 

n set 
t are 
e 
ocesses 
en 

s 
 
int. For 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
D

D

1.

2.

3.

 

Demonstra

Demonstrati

. If Demonst

• Revert 

• In the v
SQL Se
Conne
D:\107

• From t
from w

• Open a

. Open the 3

. Follow the 

 

ation 3B: V

ion Steps 

ration 1A was 

the virtual ma

virtual machin
erver Manage
ect. From the F
775A_Labs\10

he View menu
within Solution 

and follow the

32 – Demonst

instructions co

Viewing the

not performe

achines as per 

e, click Start, c
ement Studio.
File menu, clic
0775A_18_PRJ

u, click Solutio
Explorer. 

e instructions in

ration 3B.sql

ontained withi

 

e Server A

d: 

the instruction

click All Progr
. In the Conne
k Open, click P
J\10775A_18_

on Explorer. O

n the 21 – Dem

script file. 

n the commen

10775A: Administer

Activity Rep

ns in D:\10775

rams, click Mi
ect to Server w
Project/Solut
_PRJ.ssmssln

Open and exec

monstration 2

nts of the scrip

ring Microsoft SQL Se

port 

5A_Labs\Revert

icrosoft SQL S
window, type P
tion, navigate 
and click Ope

cute the 00 – S

2A.sql script f

pt file. 

erver 2012 Database

 

t.txt. 

Server 2012, c
roseware and
to 

en. 

Setup.sql scrip

file. 

es  18-29 

click 
d click 

pt file 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
18-30 Mon

Q

K

Th
de
de
th
da

SQ

• 

• 

• 

• 

• 

• 

Th
le
in

 

itoring SQL Server 20

Query Stati

Key Points 

he Query Stati
etails of expen
efault, runs ev
his collection s
ata that is coll

QL Server dete

Elapsed tim

Worker tim

Logical read

Logical writ

Physical rea

Execution c

his report also
evels of detail. 
n memory at th

Question: 

012 

istics Repo

stics Report is 
nsive queries. T
ery ten second
et is cached in
ected is retain

ermines expen

me 

me 

ds 

tes 

ads 

count 

includes a lar
As an example

he time the ca

What is meant

 

ort 

based on the 
The collection 
ds. To avoid th
n the local file 
ed for fourtee

sive queries ba

ge number of 
e, it is possible
pture was perf

t by the term "

Query Statisti
set is the mos

he overhead of
system and up

en days by defa

ased upon: 

linked sub-rep
e to retrieve qu
formed. 

"expensive que

cs System Dat
t intensive def
f constant uplo
ploaded using 
ault but this va

ports that can 
uery plans from

eries"? 

ta Collection Se
fault collection
oading, the da
SSIS every fift

alue can be ex

be used to dr
m the expensiv

 

et that retrieve
n system and, 
ata that is colle
teen minutes. T
xtended. 

rill-through to 
ve queries that

es 
by 
ected by 
The 

higher 
t were 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
D

D

1.

2.

3.

 

Demonstra

Demonstrati

. If Demonst

• Revert 

• In the v
SQL Se
Conne
D:\107

• From t
from w

• Open a

. Open the 3

. Follow the 

 

ation 3C: V

ion Steps 

ration 1A was 

the virtual ma

virtual machin
erver Manage
ect. From the F
775A_Labs\10

he View menu
within Solution 

and follow the

33 – Demonst

instructions co

Viewing the

not performe

achines as per 

e, click Start, c
ement Studio.
File menu, clic
0775A_18_PRJ

u, click Solutio
Explorer. 

e instructions in

ration 3C.sql

ontained withi

 

e Query St

d: 

the instruction

click All Progr
. In the Conne
k Open, click P
J\10775A_18_

on Explorer. O

n the 21 – Dem

script file. 

n the commen

10775A: Administer

tatistics Re

ns in D:\10775

rams, click Mi
ect to Server w
Project/Solut
_PRJ.ssmssln

Open and exec

monstration 2

nts of the scrip

ring Microsoft SQL Se

eport 

5A_Labs\Revert

icrosoft SQL S
window, type P
tion, navigate 
and click Ope

cute the 00 – S

2A.sql script f

pt file. 

erver 2012 Database

 

t.txt. 

Server 2012, c
roseware and
to 

en. 

Setup.sql scrip

file. 

es  18-31 

click 
d click 

pt file 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
18-32 Mon

Lab 1

La

Fo
co

1.

2.

3.

4.

5.

6.

7.

La

Th
fu
us

Ra
th
re

itoring SQL Server 20

18: Mon

ab Setup 

or this lab, you
omplete the fo

. Revert the v

. In the virtu
SQL Server

. In the Conn

. In the Auth

. In the File m

. In the Open
D:\10775A

. From the V
00-Setup.s

ab Scenario

he earlier versi
unctions and v
sed for collect

ather than col
he performanc
eported to the

012 

nitoring 

u will use the a
ollowing steps:

virtual machin

al machine, cli
r Managemen

nect to Server 

hentication dr

menu, click Op

n Project wind
A_Labs\10775

View menu, clic
sql. When the 

o 

ions of SQL Se
iews. You have
ing performan

lecting inform
ce information 

helpdesk at th

SQL Se

available virtua
: 

nes as per the i

ick Start, click 
nt Studio. 

window, type 

rop-down list 

pen, and click 

dow, open the 
A_18_PRJ\10

ck Solution Ex
query window

erver that you 
e recently read
nce informatio

ation separate
to a central se

he time they o

erver 20

al machine env

instructions in 

All Programs

Proseware in

box, select Wi

Project/Solut

project 
775A_18_PRJ

xplorer. In Sol
w opens, click E

have worked w
d about these 
n.  

ely for each SQ
erver. This will 
occurred.

012 

vironment. Bef

D:\10775A_La

s, click Micros

n the Server na

indows Authe

tion. 

J.ssmssln. 

lution Explore
Execute on th

with did not in
and are intere

QL Server insta
help when de

fore you begin

abs\Revert.txt. 

soft SQL Serve

ame text box. 

entication and

r, double-click
e toolbar. 

nclude dynami
ested to see ho

ance, you have
ealing with issu

 

n the lab, you 

er 2012, and c

d click Connec

k the query  

ic managemen
ow they might

e decided to co
ues that were n

 

must 

click 

ct. 

nt 
 be 

ollect all 
not 



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
 10775A: Administering Microsoft SQL Server 2012 Databases  18-33 

Exercise 1: Investigating DMVs 

Scenario 

You have been provided with a series of sample queries that can be used to provide information from 
Dynamic Management Views and to provide an insight into SQL Server activity. In this exercise, you will 
execute these queries to gain an understanding of the potential uses for DMVs. 

The main task for this exercise is as follows: 

1. Investigate the use of Dynamic Management Views and Functions. 

 Task 1: Investigate the use of Dynamic Management Views and Functions 
• Open the script file 51 - Lab Exercise 1.sql and follow the instructions contained in the script file. 

Results: After this exercise, you should have investigated the use of Dynamic Management Views 
and Functions.  

Exercise 2: Configure Management Data Warehouse 

Scenario 
You want to be able to centrally collect performance information so that you can analyze the all the 
Adventure Works performance data a later stage. In this exercise, you will configure a server to hold the 
management data warehouse to collect the performance data. 

The main task for this exercise is as follows: 

1. Create a management data warehouse for central collection of performance data.  

 Task 1: Create a management data warehouse for central collection of performance data 
• Create a management data warehouse for central collection of performance data. Create the 

management data warehouse with a database name of MDW and on the Proseware instance.  

Results: After this exercise, you should have created a management data warehouse. 

Exercise 3: Configure Instances for Data Collection 

Scenario 
You want to configure each Adventure Works SQL Server instance so that it sends performance 
information to a central server. In this exercise, you will configure each of the SQL Server instances to send 
performance data to the newly configured data warehouse. 

The main tasks for this exercise are as follows: 

1. Configure data collection on each instance.  

2. Configure data collection security for the AdventureWorks instance. 
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 Task 1: Configure data collection on each instance 
• Configure data collection on the Proseware instance. 

• Set the target for the performance data to the management data warehouse created in Exercise 2. 

• Configure data collection on the AdventureWorks instance. 

Results: After this exercise, you should have configured both instances for data collection. 

Challenge Exercise 4: Work with Data Collector Reports (Only if time 
permits) 

Scenario 

You want to create a performance report that summarizes the performance information for all of the 
Adventure Works SQL Server instances. In this exercise, you will review the reports provided by the data 
collection system. 

Note Performance data takes some time to begin to be collected. To assist with this 
exercise, you have been provided with a backup of another management data warehouse 
to use for testing reports. 

The main tasks for this exercise are as follows: 

1. Disable data collectors on both instances. 

2. Restore a backup of the MDW database. 

3. Review the available reports. 

 Task 1: Disable data collectors on both instances 
• Disable data collection on the Proseware instance. 

• Disable data collection on the AdventureWorks instance. 

 Task 2: Restore a backup of the MDW database 
• Restore the MDW database from the backup file 

D:\10775A_Labs\10775A_18_PRJ\10775A_18_PRJ\MDW.bak. 

 Task 3: Review the available reports 
• Create a server activity report. 

• Create a disk space usage report. 

• Create a query statistics report. 

Results: After this exercise, you should have worked with Management Data Warehouse Reports. 
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Module 19 
Managing Multiple Servers 

Contents: 
Lesson 1: Working with Multiple Servers 19-3 

Lesson 2: Virtualizing SQL Server 19-9 

Lesson 3: Deploying and Upgrading Data-tier Applications 19-15 

Lab 19: Managing Multiple Servers 19-22 
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While the ability to maintain central lists is useful, SQL Server 2008 and later versions provide the ability to 
perform actions against entire groups of computers. By right-clicking a group in the Registered Servers 
tool window, users can execute T-SQL statements against all servers within the group at the same time. 
Users can also use Object Browser to browse multiple servers concurrently. 

Note Users can also import and evaluate policies that are part of SQL Server Policy-Based 
Management (PBM) but PBM is an advanced topic that is out of scope for this course. 

Question: What is the main advantage of using a central management server instead of 
standard registered servers in SSMS? 
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Note the additional column called Server Name that is included in the results but was not included in the 
SELECT statement. For the execution of multi-server queries, SSMS provides options that determine how 
the results of the queries should be presented. From the Tools menu, click Options, click Query Results, 
click SQL Server, and then click Multi-server Results as shown in the following screenshot: 

 

 

 

 

 

 

 

 

 

 

By default, SSMS will merge the results from each server into a single result set and insert a first column 
that contains the name of the server. Optionally, you can remove this server name, add the login name, or 
request that the results are not merged.  

Question: What happens if the user has no permissions to execute a statement on one of 
the servers of a multi-server query? 
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Data-tier Applications 

Data-tier applications are designed to provide a similar experience for installing and upgrading database 
applications as occurs with Windows applications. The developer creates a data-tier application using 
Visual Studio, with all required objects, and defines policies that limit how the application can be installed. 
For example, a deployment policy could indicate that an application can only be installed on SQL Server 
versions 10.5 and above. 

When the data-tier application project is built, the output is a .dacpac file that can be delivered to the 
database administrator. A single .dacpac file can be used for both installing and upgrading an application 
and is portable across different environments such as development, test, staging, and production. 

Installation and upgrade of data-tier applications is automated. Data-tier applications are not designed 
for large line of business applications. The intention is to make it easy to install and upgrade large 
numbers of simpler applications. 

Question: What is a disadvantage of deploying upgrades via T-SQL scripts? 
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Exercise 1: Configure CMS and Execute Multi-server Queries 

Scenario 

You want to create a list of SQL Server instances so that each database administrator has a consistent list 
of SQL Server instances in SQL Server Management studio. You want to manage this list of servers 
centrally. In this exercise, you will configure a central management server and execute multi-server 
queries. 

The main tasks for this exercise are as follows: 

1. Create a central management server. 

2. Create a server group within the CMS. 

3. Execute a command to find all databases on any core server in full recovery model. 

 Task 1: Create a central management server 
• Create a central management server on the Proseware instance. 

 Task 2: Create a server group within the CMS 
• Create a server group called Core Servers. 

• Register the Proseware instance in the CoreServers group. 

• Register the AdventureWorks instance in the CoreServers group. 

 Task 3: Execute a command to find all databases on any core server in full recovery 
model 
• Open a multi-server query window. 

• Execute a multi-server query to find all databases in full recovery model.  

• Hint: Look for the value FULL in the recovery_model_desc column in the sys.databases view. 

Results: After this exercise, you should have created a centrally managed server group and 
executed a multi-server query.  
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Exercise 2: Deploy a Data-tier Application 

Scenario 

You want to deploy a data-tier application that has been supplied by your application development 
group. This data-tier application contains all of the database and instance objects used by an application. 
In this exercise, you will use SQL Server Management Studio to deploy a data-tier application. 

The main task for this exercise is as follows: 

1. Deploy the data-tier application using SSMS. 

 Task 1: Deploy the data-tier application using SSMS 
• Deploy the data-tier application D:\10775A_Labs\10775A_19_PRJ\10775A_19_PRJ\CityCode.dacpac as 

database name CityCode on the Proseware instance. 

• Test the data-tier application by executing the script file 61 – Lab Exercise 2.sql. 

Results: After this exercise, you should have deployed a data-tier application. 

Exercise 3: Register and Extract a Data-tier Application 

Scenario 

You want to encapsulate all of the database and instance objects used by an existing application into a 
single package that you can email. In this exercise, you will register an existing database as a data-tier 
application. You will also extract a data-tier application to send to the development team. 

The main tasks for this exercise are as follows: 

1. Register the existing database as a data-tier application. 

2. Extract a dacpac from the database to send to the development team. 

 Task 1: Register the existing database as a data-tier application 
• Register the Research database as a data-tier application. 

 Task 2: Extract a dacpac from the database to send to the development team 
• Extract a dacpac from the Research database, to the file D:\MKTG\Research.dacpac.  

Results: After this exercise, you should have registered the Research database as a 
data-tier application and extracted a DAC package file. 
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Challenge Exercise 4: Upgrade a Data-tier Application (Only if time 
permits) 

Scenario 
The application development group has provided you with a new version of the database schema as a 
data-tier application. You want to deploy this new version of the schema. In this exercise, you will upgrade 
the existing data-tier application. 

Note: Two versions of the updated data-tier application have been supplied. The first (CityCode_v2) will 
cause an error when you attempt to deploy it. The intention is to allow you to see that the system is not 
left in an unknown state. The second version (CityCode_v3) should deploy successfully. 

The main tasks for this exercise are as follows: 

1. Attempt to deploy the v2 upgrade. 

2. Deploy the v3 upgrade. 

 Task 1: Attempt to deploy the v2 upgrade 
• Attempt to deploy the v2 upgrade from the file 

D:\10775A_Labs\10775A_19_PRJ\10775A_19_PRJ\CityCode_v2.dacpac. 

 Task 2: Deploy the v3 upgrade 
• Deploy the v3 upgrade from the file 

D:\10775A_Labs\10775A_19_PRJ\10775A_19_PRJ\CityCode_v3.dacpac. 

Results: After this exercise, you should have upgraded the data-tier application. 
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Module 20 
Troubleshooting Common SQL Server 2012 Administrative 
Issues 

Contents: 
Lesson 1: SQL Server Troubleshooting Methodology 20-3 

Lesson 2: Resolving Service-related Issues 20-7 

Lesson 3: Resolving Login and Connectivity Issues 20-13 

Lesson 4: Resolving Concurrency Issues 20-17 

Lab 20: Troubleshooting Common Issues 20-25 
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20-6 Troubleshooting Common SQL Server 2012 Administrative Issues 

Analysis Phase 

In the analysis phase, you need to determine all possible causes of the issue that you are trying to resolve. 
At this point, it is important to avoid excluding any potential causes, no matter how unlikely you consider 
them to be.  

A brainstorming session with another person is often useful in this phase, particularly if that person is 
capable of constantly providing alternative viewpoints during discussions. (In many countries, this person 
would be described as being good at playing the Devil's advocate). The analysis phase often benefits from 
two types of people, one of whom has excellent technical knowledge of the product, and another that 
constantly requires the first person to justify their thoughts and to think both logically and laterally. 

Implementation Phase 

In the implementation phase, you need to eliminate each potential cause. This process of elimination 
usually returns the best results when the potential causes are eliminated in order from the most likely 
cause to the least likely cause. 

The critical aspect of the implementation phase is to make sure that your reasons for eliminating potential 
causes are logically valid. 

If you reach the end of your list of potential causes and have not yet found a solution to the issue, you 
need to return to the analysis phase and recheck your thinking. If you cannot find a problem in your 
analysis, you might even need to go back to recheck your initial assumptions in the investigation phase. 

Validation Phase 

Too many people, particularly those that are new to troubleshooting, assume that problems are resolved 
when they are not. Do not assume that because you have found and resolved a problem that it was the 
original problem that you have solved. 

In the investigation phase, you should have determined how the user would decide if the issue is resolved. 
In the validation phase, you need to apply that test to see if the issue really is resolved. 

Documentation 

After the problem is resolved, it is really important to make sure that all in the organization learn from 
what happened. 

Question: How do you know that a problem is resolved?  
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 10775A: Administering Microsoft SQL Server 2012 Databases  20-9 

If SQL Server will not start but the issue isn't a logon issue, check the following: 

• Check whether the SQL Server log files indicate that the master or model database is corrupt. If either 
of these databases is corrupt, follow the procedures to recover the databases that were described in 
Module 7. 

• Check whether or not the file paths to the tempdb database files are accessible. The tempdb database 
is recreated each time the server instance starts but the path to the database files (as configured in 
the master database) must exist and be accessible. 

• Try to start the instance using the command prompt. If starting SQL Server from a command prompt 
does work, check the configuration of the service and make sure that the permission requirements 
are met.  

Question: What should be reviewed first when a service-related issue happens with SQL 
Server? 
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(continued) 

Issue Actions

Can the network and the server be 
reached? 

While a server name might be successfully resolved to a 
network address, no connectivity may be possible between 
the client and server systems. On TCP/IP networks, make 
sure that you can successfully ping the server that SQL 
Server is installed on, assuming that it does not have the 
ability to echo ping commands disabled. In many cases, 
problems in this area will relate to incorrect subnet or 
default gateway/router addresses. 

Is the Browser Service Running for 
Named Instances that are not using 
fixed ports? 

If you are using named instances of SQL Server, the client 
systems need to be able to resolve the names of the 
instances to a port number. By default, this is achieved by 
connecting to the SQL Browser service on UDP port 1434. If 
the SQL Browser service is disabled, the named instances 
need to be configured to use fixed ports and the client 
systems need to be configured to access those ports, 
potentially by the creation of aliases. Make sure that the 
aliases are created for the correct network library such as 32 
bit vs. 64 bit. 

Is the client configured to use the 
right protocol and settings? 

Is the protocol that the client is attempting to use to 
connect to the server, actually enabled on the server? Are 
the protocol settings appropriate? 

Is a firewall blocking connectivity? Check to make sure that there is no firewall that is blocking 
the ports that you are trying to connect over. If a firewall is 
blocking your access, an exception or rule will likely need to 
be configured in the firewall. 

 

Question: Why should a local connection be tested first? 
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To achieve the isolation requirements, SQL Server uses a locking scheme. Locking is a mechanism used by 
the database engine to synchronize access by multiple users to the same piece of data at the same time. 
The aim is to maximize concurrency while maintaining the ACID properties. 

Note Concurrency is discussed in detail in course 10776A: Developing Microsoft SQL 
Server 2012 Databases. 

Locking Behavior 

Before a transaction acquires a dependency on the current state of a data element, such as by reading or 
modifying the data, it must protect itself from the effects of another transaction that attempts to modify 
the same data. The transaction does this by requesting a lock on the data element. Locks have different 
modes, such as shared or exclusive. The locking mode defines the level of dependency the transaction has 
on the data.  

No transaction can be granted a lock that would conflict with the mode of a lock that has already been 
granted to another transaction on that same data. If a transaction requests a lock mode that conflicts with 
a lock that has already been granted on the same data, the database engine will block the requesting 
transaction until the first lock is released. 

For UPDATE operations, SQL Server always holds locks to the end of the transaction. For SELECT 
operations, it holds the lock protecting the row for a period that depends upon the transaction isolation 
level setting. All locks that are still held when a transaction completes are released, whether the 
transaction commits or rolls back. 

Locking is crucial for transaction processing and is normal behavior for the system. Problems only occur 
when locks are held for too long and other transactions are blocked for too long because of the locks that 
are being held.  

Question: Why would SELECT statements acquire locks in most cases? 
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How SQL Server Ends a Deadlock 

SQL Server ends a deadlock by automatically terminating one of the transactions. SQL Server does the 
following: 

• Chooses a deadlock victim. SQL Server gives priority to the process that has the highest deadlock 
priority. If both processes have the same deadlock priority, SQL Server rolls back the transaction that 
is the least costly to rollback. 

• Rolls back the transaction of the deadlock victim.  

• Notifies the deadlock victim’s application (with message number 1205). 

• Allows the other transaction to continue. 

Important In a multi-user environment, each client should check for message number 
1205, which indicates that the transaction was rolled back. If message 1205 is found, the 
application should reconnect and try the transaction again. 

Working with Deadlocks 

Deadlocks are normally not logged. The only indication that a deadlock has occurred is that an error 
message is returned to the client that has been selected as the victim. 

To monitor deadlocks use SQL Server Profiler and/or SQL Trace. There are several deadlock events 
available. The event with most information and that is easiest to read is the Deadlock Graph event. You 
will see an example of a deadlock graph in Demonstration 3B. 

Note that there are other tools that can help with deadlocks that are out of scope for this course: 

• Trace flags can be set to write deadlock information to the SQL Server Error Log. 

• Event Notifications can be generated. 

• Extended events can be tracked. 

Question: Have you experienced deadlocking problems in your current environment? If so, 
how did you determine that deadlocks were a problem, and how was it resolved? 
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Supporting Documentation 

Exercise 1 

Users of the Promote application are complaining that the application can no longer connect to the 
server. The application connects using the SQL Login PromoteApp.  

Exercise 2 

A junior DBA created a backup of the production AdminDB database to send to the development team 
for testing. Now users of that database are complaining they can no longer connect to it.  

Exercise 3 

Users are complaining that the job Get File List in SQL Server Agent is failing to execute.  

Exercise 4 

The performance of the AdminDB database has been steadily reducing since the database was deployed. 
Queries that once took seconds are now taking minutes.  

Exercise 5 

A strange situation is occurring with the CityDetails database. Most databases work slower as more users 
are added. However, the CityDetails database performs the worst when only a single user connects to it. 
The connection time for just this database can be very long and sometimes times out. Other databases  
are OK. 

Exercises 1 - 5: Troubleshoot and Resolve SQL Server Administrative Issues 

Scenario 
A number of issues have been reported by the users of the Proseware server. You need to troubleshoot 
and resolve the issues. 

The main tasks for each exercise are as follows: 

1. Read the supporting documentation for the exercise. 

2. Troubleshoot and resolve the issue. 

 Task 1: Read the supporting documentation for the exercise 
• Read the supporting documentation for the exercise. 

 Task 2: Troubleshoot and resolve the issue 
• Troubleshoot the issue. 

• Resolve the issue. 

• If you have difficulty, check the solution in the LAK. 

Results: After these exercise, you should have investigated and resolved a number of issues.  
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Appendix A 
Core Concepts in SQL Server High Availability and 
Replication 

Contents: 
Lesson 1: Core Concepts in High Availability A-3 

Lesson 2: Core Concepts in Replication A-11 
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A witness server can be any edition of SQL Server including the Express edition, and should reside on 
another physical server, separate to both the principal server and the mirror partner. The witness server is 
used to provide a quorum with the mirror partner server, where they can agree that the principal server 
has failed and that a failover should occur. During a failure, if an automated failover cannot occur, it is 
possible to "force service" by switching the mirror partner into the principal role, even though a loss of 
data could occur.  

Note that system databases such as master, msdb, tempdb, and the model database cannot be mirrored. 
SQL Server 2008 improved the performance of database mirroring through the introduction of log stream 
compression. While only a single mirror could be provided for each database, many more databases could 
be concurrently mirrored. 

Mirroring can improve the availability of databases, including times when routine maintenance such as 
applying service packs is needed. The data held on the mirror partner is not accessible unless a database 
snapshot is created on the mirror to provide read-only access to the data. 

The biggest limitation of database mirroring is that databases often have external dependencies such as 
logins in the master database. Mechanisms or processes need to be put in place to ensure that these 
dependent objects are present on both the servers. 
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A remote distributor might be used to minimize the network traffic between the distributor and a number 
of subscribers by placing the distributor close to the subscribers. In a push subscription, the distributor 
sends the data to the subscriber. In a pull subscription, the subscriber retrieves the data from the 
distributor. 
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Module 1: Introduction to SQL Server 2012 and Its Toolset  

Lab 1: Introduction to SQL Server and Its 
Toolset 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following step: 

• Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

Exercise 1: Verify SQL Server Component Installation 

  Task 1: Check that Database Engine and Reporting Services have been installed for the 
MKTG instance 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, click Configuration Tools, and 
then click SQL Server Configuration Manager.  

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. In the right-hand pane, ensure that the following services are listed for the MKTG instance: 

• SQL Server (MKTG) 

• SQL Full-text Filter Daemon Launcher (MKTG) 

• SQL Server Reporting Services (MKTG) 

• SQL Server Agent (MKTG) 

  Task 2: Note the services that are installed for the default instance  

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. In the right-hand pane, ensure that the following services are listed for the default instance: 

• SQL Server (MSSQLSERVER) 

• SQL Full-text Filter Daemon Launcher (MSSQLSERVER) 

• SQL Server Analysis Services (MSSQLSERVER) 

• SQL Server Agent (MSSQLSERVER) 

  Task 3: Ensure that all required services including SQL Server Agent are started and set 
to autostart for both instances 

1. Check that all the services for the MKTG instance have a Start Mode of Automatic. Ignore the SQL 
Full-text Filter Daemon Launcher service at this time. 

2. Check that all the services for the default instance have a Start Mode of Automatic. Ignore the SQL 
Full-text Filter Daemon Launcher service at this time. 
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Exercise 2: Alter Service Accounts for New Instance 

  Task 1: Change the service account for the MKTG database engine 

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. In the right-hand pane, right-click SQL Server (MTKG), and select Properties. 

3. In the Account Name text box, type AdventureWorks\PWService. 

4. In the Password text box, type Pa$$w0rd. 

5. In the Confirm Password text box, type Pa$$w0rd and click OK. 

6. In the Confirm Account Change window, click Yes. 

  Task 2: Change the service account for the MKTG SQL Server Agent 

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. In the right-hand pane, right-click SQL Server Agent (MTKG), and select Properties. 

3. In the Account Name text box, type: 

• AdventureWorks\PWService. 

4. In the Password text box, type Pa$$w0rd. 

5. In the Confirm Password text box, type Pa$$w0rd and click OK. 

6. Right-click SQL Server Agent (MTKG) and select Start to restart the service. 

Exercise 3: Enable Named Pipes Protocol for Both Instances 

  Task 1: Enable the named pipes protocol for the default instance 

1. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Server 
Network Configuration and then click Protocols for MSSQLSERVER. 

2. In the right-hand pane, if the Named Pipes protocol is not enabled, right-click Named Pipes and 
select Enable. In the Warning window, click OK. 

  Task 2: Enable the named pipes protocol for the MKTG instance 

1. In the left-hand pane of the SQL Server Configuration Manager window, click Protocols for MKTG. 

2. In the right-hand pane, if the Named Pipes protocol is not enabled, right-click Named Pipes and 
select Enable. In the Warning window, click OK. 

  Task 3: Restart both database engine services  

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. Right-click SQL Server (MSSQLSERVER) and select Restart. 

3. Right-click SQL Server (MKTG) and select Restart. 

4. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

5. In the toolbar, click the Refresh icon. 
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Exercise 4: Create an Alias for AdvDev 

  Task 1: Create a 32-bit alias (AdvDev) for the MKTG instance 

1. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Native Client 
11.0 Configuration (32bit) and click Client Protocols. 

2. Confirm that the Named Pipes protocol is Enabled. 

3. In the left-hand pane, click Aliases. 

4. In the left-hand pane, right-click Aliases and select New Alias. 

5. In the Alias – New window, in the Alias Name text box, type AdvDev. 

6. In the Protocol drop-down list box, select Named Pipes. 

7. In the Server text box, type .\MKTG and click OK. 

  Task 2: Create a 64-bit alias (AdvDev) for the MKTG instance  

1. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Native Client 
11.0 Configuration and click Client Protocols. 

2. Confirm that the Named Pipes protocol is Enabled. 

3. In the left-hand pane, click Aliases. 

4. In the left-hand pane, right-click Aliases and select New Alias. 

5. In the Alias – New window, in the Alias Name text box, type AdvDev. 

6. In the Protocol drop-down list box, select Named Pipes. 

7. In the Server text box, type .\MKTG and click OK. 

  Task 3: Use SQL Server Management Studio to connect to the alias to ensure it works as 
expected  

1. Click Start, click All Programs, click Microsoft SQL Server 2012, and then click SQL Server 
Management Studio. 

2. In the Connect to Server window, ensure that Server Type is set to Database Engine. 

3. In the Server name text box, type AdvDev. 

4. In the Authentication drop-down list, select Windows Authentication, and click Connect. 

5. In Object Explorer, under AdvDev expand Databases.  

Note: The databases that are present include at least the following: System Databases, 
Database Snapshots, ReportServer$MKTG, and ReportServer$MKTGTempDB. 

6. Close SQL Server Management Studio. 

7. Close SQL Server Configuration Manager.  
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Challenge Exercise 5: Ensure SQL Browser is Disabled and Configure a 
Fixed TCP/IP Port (Only if time permits) 

  Task 1: Configure the TCP port for the MKTG database engine instance to 51550 

1. In the Virtual Machine window, from the Start menu, click All Programs, click Microsoft SQL Server 
2012, click Configuration Tools, and then click SQL Server Configuration Manager.  

2. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Server 
Network Configuration and then click Protocols for MKTG. 

3. Right-click the TCP/IP protocol and select Properties. 

4. In the TCP/IP Properties window, click IP Addresses tab. 

5. Scroll to the bottom of the screen, under the IP All section, clear the value for TCP Dynamic Ports. 

6. For TCP Port, type 51550, and click OK. 

7. In the Warning window, click OK. 

8. In the left-hand pane, click SQL Server Services. 

9. Right-click SQL Server (MKTG) and select Restart. 

10. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

11. In the toolbar, click the Refresh icon and make sure the service starts. 

  Task 2: Disable the SQLBrowser service 

1. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

2. In the right-hand pane, if the state for the SQL Server Browser is Running, right-click SQL Server 
Browser and click Stop. 

3. Right-click the SQL Server Browser and click Properties. 

4. In the SQL Server Browser Properties window, in the Service tab, set the Start Mode to Disabled and 
click OK. 

5. Close SQL Server Configuration Manager. 
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Module 2: Preparing Systems for SQL Server 2012  

Lab 2: Preparing Systems for SQL Server 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_02_PRJ\10775A_02_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Adjust Memory Configuration 

  Task 1: Check total server memory 

1. Click Start, right-click Computer, and click Properties. 

2. Write down the value for Installed memory (RAM). 

3. Close the System window. 

  Task 2: Check the memory allocated to the default instance  

1. Click Start, click All Programs, click Microsoft SQL Server 2012, and click SQL Server 
Management Studio. 

2. In the Connect to Server window, type AdventureWorks for the Server name and click Connect. 

3. In Object Explorer, right-click the AdventureWorks server instance, and click Properties. 

4. In the Select a page pane click Memory.  

5. Write down the values for Minimum server memory (in MB) and Maximum server memory (in 
MB), and click Cancel. 

6. In SQL Server Management Studio, from the File menu, click Exit. 
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  Task 3: Check the memory allocated to the MKTG instance 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, and click SQL Server 
Management Studio. 

2. In the Connect to Server window, type Proseware for the Server name and click Connect. 

3. In Object Explorer, right-click the Proseware server instance, and click Properties. 

4. In the Select a page pane click Memory.  

5. Write down the values for Minimum server memory (in MB) and Maximum server memory (in 
MB), and click Cancel. 

6. In SQL Server Management Studio, from the File menu, click Exit. 

  Task 4: Decide if the memory allocation is appropriate. If not, make the required 
changes to the memory configuration 

1. Review the Required Memory Configuration from the Supporting Documentation in the Student 
Manual. 

2. Calculate the Maximum memory for the AdventureWorks server instance as follows: 

• Example calculation (actual values depend upon VM configuration) 

• Max Memory = (Server Memory – 1.5GB) * 0.6 

• Max Memory = (3.0 – 1.5) * 0.6  

• Max Memory = 0.9 (approximate) 

3. Calculate the Maximum memory for the Proseware server instance as follows: 

• Example calculation (actual values depend upon VM configuration) 

• Max Memory = (Server Memory – 1.5GB) * 0.4 

• Max Memory = (3.0 – 1.5) * 0.4 

• Max Memory = 0.6 (approximate) 

4. Click Start, click All Programs, click Microsoft SQL Server 2012, and click SQL Server 
Management Studio. 

5. In the Connect to Server window, type AdventureWorks for the Server name and click Connect. 

6. In Object Explorer, right-click the AdventureWorks server instance, and click Properties. 

7. In the Select a page pane click Memory. 

8. Set the Maximum server memory (in MB) to the value 900, and click OK. 

Note: A more accurate value for 0.9GB would have been 921MB, but the value 900 has 
been used for simplicity. 
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9. In Object Explorer click Connect, and click Database Engine. 

10. In the Connect to Server window, type Proseware for the Server name and click Connect. 

11. In Object Explorer, right-click the Proseware server instance, and click Properties. 

12. In the Select a page pane click Memory. 

13. Set the Maximum server memory (in MB) to the value 600, and click OK. 

Note: A more accurate value for 0.6GB would have been 614MB, but the value 600 has been 
used for simplicity. 

Exercise 2: Pre-installation Stress Testing 

  Task 1: Configure SQLIOSIM 

1. In the folder D:\10775A_Labs\10775A_02_PRJ, right-click sqliosimx64.exe and click Run as 
administrator. 

2. In the Microsoft SQL Server IO Simulator window, note the agreement and click Yes. 

3. In the WinZip Self-Extractor - SQLIOS~1.EXE window click Unzip. 

4. In the WinZip Self-Extractor window click OK. 

5. In the WinZip Self-Extractor - SQLIOS~1.EXE window click Close. 

6. Open Windows Explorer and navigate to the C:\SQLIOSimX64 folder. Note that two versions of 
SQLIOSim are supplied: a command line version and a GUI version. Right-click SQLIOSim.exe, and 
click Run as administrator. 

7. In the Files and Configuration window click on the line containing C:\sqliosim.mdx, then click 
Remove. 

8. In the Files and Configuration window click on the line containing C:\sqliosim.ldx, then click 
Remove. 

9. In the Files and Configuration window click on the line containing D:\sqliosim.ldx, then click 
Remove. 

10. In the Files and Configuration window click on the line containing L:\sqliosim.mdx, then click 
Remove. 

11. In the Files and Configuration window click on the line containing D:\sqliosim.mdx, then in the 
Size (MB) change the value from 4096 to 100, also change the Max Size value from 8192 to 200, 
and the Increment to 20, then click Apply. 

12. On the line containing L:\sqliosim.ldx, set the Size (MB) to 50, the Max Size to 100, the 
Increment to 10, and click Apply. 

13. Change the Cycle Duration (sec) value from 300 to 60. 

14. Ensure that the Delete Files at Shutdown checkbox is checked, and click OK to complete the 
configuration. 
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  Task 2: Execute SQLIOSIM 

1. In the SQLIOSIM window from the Simulator menu, click Start. 

2. Wait for the test to complete in about 1 minute. While the test is running, note the information that 
is displayed.  

3. In the SQLIOSim window click OK. 

  Task 3: Review the results from executing SQLIOSIM 

1. If any errors are returned in red, review the errors.  

2. Locate the final summary for file D:\sqliosim.mdx and note the Running Average IO  
Duration (ms).  

3. Locate the final summary for file L:\sqliosim.ldx and note the Running Average IO  
Duration (ms).   

Note: The value returned for each drive depends upon the speed of the hardware. A typical 
value for either drive would be 15. 

4. In the SQLIOSim window from the File menu click Exit. 

Challenge Exercise 3: Check Specific I/O Operations (Only if time permits) 

  Task 1: Install the SQLIO Utility 

1. In the folder D:\10775A_Labs\10775A_02_PRJ, right-click SQLIO.msi and click Install. 

2. In the Welcome to the SQLIO Setup Wizard window click Next. 

3. In the License Agreement window, note the agreement click the I Agree radio button, and click 
Next. 

4. In the Select Installation Folder window click the Everyone radio button, and click Next. 

5. In the Confirm Installation window click Next. 

6. In the Installation Complete window click Close. 

  Task 2: Configure and Execute the SQLIO Utility 

1. Review the Supporting Documentation in the Student Manual for details of the SQLIO tests to be 
performed. 

2. In Windows Explorer, navigate to the C:\Program Files (x86)\SQLIO folder.  

3. Double-click the file param.txt. Place a # at the beginning of the line c:\testfile.dat. Remove the # 
from the line beginning d:\testfile.dat. 

4. From the File menu click Exit. 

5. In the Notepad window click Save. 

6. In Windows Explorer, double-click the file C:\Program Files (x86)\SQLIO\Using SQLIO.rtf. Note 
the examples and descriptions of the available parameters for SQLIO.  

  



M
C

T
 U

SE O
N

LY. ST
U

D
EN

T
 U

SE P
R

O
H

IB
IT

ED
 Lab 2: Preparing Systems for SQL Server  L2-9 

 

7. Close the using SQLIO.rtf - WordPad window.  

8. From the Start menu, click All Programs, click Accessories, right-click Command Prompt and 
click Run as administrator. 

9. Type CD \Program Files (x86)\SQLIO and press Enter. 

10. Type the following command and press Enter: 

sqlio.exe -kR -s60 -fsequential -o8 –b64 -LS -Fparam.txt timeout /T 60  

11. Look through the output of the command, note the values returned for IOs/sec and MBs/sec. These 
values are commonly referred to as IOPS and throughput. Note the minimum, maximum and 
average latency. 

12. Type the following command and press Enter: 

sqlio.exe -kW -s60 -frandom -o8 –b8 -LS -Fparam.txt timeout /T 60  

13. Look through the output of the command, note the values returned for IOs/sec and MBs/sec. These 
values are commonly referred to as IOPS and throughput. Note the minimum, maximum and 
average latency. 

14. Type Exit and press Enter. 
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Module 3: Installing and Configuring SQL Server 2012 

Lab 3: Installing and Configuring SQL 
Server 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_03_PRJ\10775A_03_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

8. On the host system, in the Virtual Machines list in Hyper-V Manager, right-click the  
10775A-MIA-SQL1 virtual machine and click Settings. 

9. In the Settings for 10775A-MIA-SQL1 window, in the Hardware list expand IDE Controller 1, and 
click DVD Drive. 

10. In the DVD Drive properties pane, click Image file, and click browse. 

11. Navigate to the file C:\Program Files\Microsoft Learning\10775\Drives\10775A-MIA-SQL1 
\Virtual Hard Disks\SQLFULL_ENU.iso and click Open. 

12. In the Settings for 10775A-MIA-SQL1 window, click OK. 

Exercise 1: Review installation requirements 

  Task 1: Review the supporting documentation prior to installation 

• Read the supporting documentation in the student manual. 

  Task 2: Create the folders that are required for the data and log files 

• Using Windows Explorer, create the following folders:  

• D:\MKTGDEV 

• L:\MKTGDEV 
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Exercise 2: Install the SQL Server Instance 

  Task 1: Based on the requirements reviewed in exercise 1, install another instance of 
SQL Server 

1. In the Virtual Machine window, in the AutoPlay window (which should now have popped up) click 
Run SETUP.EXE and wait for SQL Server Setup to start. (If the AutoPlay window has not launched, 
or you have inadvertently closed it, double-click SETUP.EXE in the root of the new drive that has 
been mounted when you connected the ISO file to your virtual machine). 

2. In the SQL Server Installation Center window, click on the Installation tab.  

3. Click New SQL Server stand-alone installation or add features to an existing installation from 
the list of available options and wait for SQL Server setup to start.  

4. In the Setup Support Rules window, click Show details and note that the list of rules that has been 
checked.  

5. In the Setup Support Rules window, click OK. 

6. Make sure that Send feature usage data to Microsoft is not selected and click Next. 

Note In general, you are encouraged to choose this feature as it helps Microsoft 
produce a better product. In this case, we are deselecting it because we are in an isolated 
environment without network access within the virtual machine. 

7. In the Product Updates window, uncheck Include SQL Server product updates and click Next. 
(Note the next screen might take some time to display.) 

8. In the Setup Support Rules page, click Show details (if visible) and read the installation checklist 
and check to make sure the Status for items have Passed. Note any warnings that are listed and 
click Next. 

9. In the Installation Type page, ensure the option button Perform a new installation of SQL 
Server 2012 is selected and then click Next. 

10. In the Product Key window, click Next. 

11. In the License Terms page, note the Microsoft Software License Terms and check I accept the 
license terms. 

12. In the Setup Role page, ensure that SQL Server Feature Installation is selected and click Next. 

13. In the Feature Selection page, under the Instance Features check Database Engine Services and 
click Next. 

14. In the Installation Rules page, click Show details, note the list of rules and the status of each rule 
and click Next. 

15. In the Instance Configuration page, ensure that Named instance is checked and type MKTGDEV 
in the Named instance field and click Next. 

16. In the Disk Space Requirements page, read the Disk Usage Summary and then click Next. 
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17. In the Server Configuration page, click the Account Name field for the SQL Server Database 
Engine row and select <<Browse…>> from the drop-down list. 

18. In the Select User, Computer, Service Account, or Group window, in the Enter the object name to 
select (Examples): dialog box type AdventureWorks\PWService, click Check Names and click 
OK. 

19. In the Password column for the SQL Server Database Engine row, type Pa$$w0rd. 

20. In the Server Configuration page, click the Account Name field for the SQL Server Agent row 
and click <<Browse…>> from the drop-down list. 

21. In the Select User, Computer, Service Account, or Group window, in the Enter the object name to 
select (Examples): dialog box type AdventureWorks\PWService, click Check Names and click 
OK. 

22. In the Password column for the SQL Server Agent row, type Pa$$w0rd. 

23. In the Server Configuration page, in the Service Accounts tab, and in the Startup Type drop-
down list for the SQL Server Agent select Automatic. 

24. Click the Collation tab, ensure that SQL_Latin1_General_CP1_CI_AS is selected and click Next. 

25. In the Database Engine Configuration page, on the Server Configuration tab, in the 
Authentication Mode section, ensure that Mixed Mode (SQL Server authentication and 
Windows authentication) is selected. 

26. In the Enter password textbox, type Pa$$w0rd. 

27. In the Confirm password textbox, type Pa$$w0rd. 

28. Click Add Current User, this will add the user ADVENTUREWORKS\administrator 
(Administrator) to the list of Administrators. 

29. Click the Data Directories tab, change the User database directory to D:\MKTGDEV. 

30. Change the User database log directory to L:\MKTGDEV. 

31. Change the Temp DB directory to D:\MKTGDEV. 

32. Change the Temp DB log directory to L:\MKTGDEV. 

33. Click the FILESTREAM tab, and ensure that Enable FILESTREAM for Transact-SQL access is not 
selected and click Next. 

34. In the Error Reporting page, make sure that Send Windows and SQL Server Error Reports to 
Microsoft or your corporate report server is not checked, then click Next. 

35. In the Installation Configuration Rules page, Show details, review the list of rules, and click 
Next. 

36. In the Ready to Install page, review the summary and click Install. 

37. In the Complete page, click Close. 

38. Close the SQL Server Installation Center window. 
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Exercise 3: Perform Post-installation Setup and Checks 

  Task 1: Check that the services for the new SQL Server instance are running 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, click Configuration Tools, and 
then click SQL Server Configuration Manager.  

2. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

3. In the right-hand pane, ensure that the following services are listed as running for the MKTGDEV 
instance: 

• SQL Server (MKTGDEV) 

• SQL Server Agent (MKTGDEV) 

  Task 2: Configure both 32 bit and 64 bit aliases for the new instance 

1. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Server 
Network Configuration and then click Protocols for MKTGDEV. 

2. In the right-hand pane, right-click Named Pipes and select Enable. 

3. In the Warning window, click OK. 

4. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

5. Right-click SQL Server (MKTGDEV) and select Restart. 

6. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

7. In the toolbar, click the Refresh icon. 

8. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Native Client 
11.0 Configuration (32bit) and click Client Protocols. 

9. Confirm that the Named Pipes protocol is Enabled. 

10. In the left-hand pane, right-click Aliases and select New Alias. 

11. In the Alias – New window, in the Alias Name text box, type PWDev. 

12. In the Protocol drop-down list box, select Named Pipes. 

13. In the Server text box, type .\MKTGDEV and click OK. 

14. In the left-hand pane of the SQL Server Configuration Manager window, expand SQL Native Client 
11.0 Configuration and click Client Protocols. 

15. Confirm that the Named Pipes protocol is Enabled. 

16. In the left-hand pane, right-click Aliases and select New Alias. 

17. In the Alias – New window, in the Alias Name text box, type PWDev. 

18. In the Protocol drop-down list box, select Named Pipes. 

19. In the Server text box, type .\MKTGDEV and click OK. 

20. Close SQL Server Configuration Manager.  
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  Task 3: Connect to the new instance using SSMS 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, and then click SQL Server 
Management Studio. 

2. In the Connect to Server window, ensure that Server Type is set to Database Engine. 

3. In the Server name text box, type PWDev. 

4. In the Authentication drop-down list, select Windows Authentication, and click Connect. 

5. In Object Explorer, under PWDev expand Databases.  

6. Close SQL Server Management Studio. 

 

Challenge Exercise 4: Configure Server Memory (Only if time permits) 

  Task 1: Review the current memory available on the server 

1. Click Start, right-click Computer, and click Properties. 

2. Write down the value for Installed memory (RAM). 

  Task 2: Determine an appropriate memory allocation for each instance 

1. Review the Required Memory Configuration from the Supporting Documentation in the Student 
Manual. 

2. Calculate the Maximum memory for the AdventureWorks server instance as follows: 

• Example calculation (actual values depend upon VM configuration) 

• Max Memory = (Server Memory – 1.0GB) * 0.4 

• Max Memory = (3.0 – 1.0) * 0.4  

• Max Memory = 0.8 (approximate) 

3. Calculate the Maximum memory for the Proseware server instance as follows: 

• Example calculation (actual values depend upon VM configuration) 

• Max Memory = (Server Memory – 1.0GB) * 0.3 

• Max Memory = (3.0 – 1.0) * 0.3  

• Max Memory = 0.6 (approximate)   

4. Calculate the Maximum memory for the PWDev server instance as follows: 

• Example calculation (actual values depend upon VM configuration) 

• Max Memory = (Server Memory – 1.0GB) * 0.3 

• Max Memory = (3.0 – 1.0) * 0.3  

• Max Memory = 0.6 (approximate)   
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  Task 3: Configure each instance appropriately 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, and click SQL Server 
Management Studio. 

2. In the Connect to Server window, type AdventureWorks for the Server name and click Connect. 

3. In Object Explorer, right-click the AdventureWorks server instance, and click Properties. 

4. In the Select a page pane click Memory. 

5. Set the Maximum server memory (in MB) to the value 800, and click OK. 

Note A more precise value could have been used but the value 800 has been used for 
simplicity. 

6. In Object Explorer click Connect, and click Database Engine. 

7. In the Connect to Server window, type Proseware for the Server name and click Connect. 

8. In Object Explorer, right-click the Proseware server instance, and click Properties. 

9. In the Select a page pane click Memory. 

10. Set the Maximum server memory (in MB) to the value 600, and click OK. 

Note A more precise value for 1.0GB could have been used but the value 600 has been 
used for simplicity. 

11. In Object Explorer click Connect, and click Database Engine. 

12. In the Connect to Server window, type PWDev for the Server name and click Connect. 

13. In Object Explorer, right-click the PWDev server instance, and click Properties. 

14. In the Select a page pane click Memory. 

15. Set the Maximum server memory (in MB) to the value 600, and click OK. 

Note A more accurate value for 1.0GB could have been used but the value 600 has 
been used for simplicity. 

16. Close SQL Server Management Studio. 
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Module 4: Working with Databases  

Lab 4: Working with Databases 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_04_PRJ\10775A_04_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Adjust tempdb Configuration 

  Task 1: Adjust the size of tempdb 

1. Review the requirement for tempdb size in the Supporting Documentation. 

2. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

3. Enter the following statements and click Execute: 

USE master; 
GO 
ALTER DATABASE tempdb 
  MODIFY FILE ( NAME = tempdev, SIZE = 30MB ); 
GO 
ALTER DATABASE tempdb 
  MODIFY FILE ( NAME = templog, SIZE = 10MB ); 
GO 

  Task 2: Check that the tempdb size is still correct after a restart 
1. Click Start, click All Programs, click Microsoft SQL Server 2012, click Configuration Tools, and 

then click SQL Server Configuration Manager.  

2. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

3. In the right-hand pane, right-click the service SQL Server (MKTG) and click restart. 

4. In Object Explorer, right-click the tempdb database and click Properties. 

5. In the Database Properties – tempdb window, click Files in the Select a page pane. 

6. In the Database files list, check that the initial size of the data file is 30 and the initial size of the 
log file is 10.  
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Exercise 2: Create the RateTracking Database 

  Task 1: Create the database 

1. Review the supplied requirements in the supporting documentation for the exercise.  

2. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

3. Enter the following statements and click Execute: 

USE master; 
GO 
 
CREATE DATABASE RateTracking 
ON  
( NAME = RateTracking_dat,  
  FILENAME = 'D:\MKTG\RateTracking.mdf',    
  SIZE = 10MB, MAXSIZE = 100MB,   
  FILEGROWTH = 10MB  
) 
LOG ON 
( NAME = RateTracking_log, 
  FILENAME = 'L:\MKTG\RateTracking.ldf',   
  SIZE = 20MB,  
  MAXSIZE = UNLIMITED,   
  FILEGROWTH = 20MB  
); 
GO 

  Task 2: Create the required filegroups and files 

1. Review the supplied requirements in the supporting documentation for the required files and 
filegroups. 

2. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

3. Enter the following statements and click Execute: 

USE master; 
GO 
 
ALTER DATABASE RateTracking 
ADD FILEGROUP USERDATA; 
GO 
 
ALTER DATABASE RateTracking  
ADD FILE  
( NAME = RateTracking_dat_1,  
  FILENAME = 'D:\MKTG\RateTracking_1.ndf',    
  SIZE = 20MB,  
  MAXSIZE = 100MB,   
  FILEGROWTH = 10MB  
) TO FILEGROUP USERDATA; 
GO 

(code continued on next page) 
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ALTER DATABASE RateTracking  
ADD FILE  
( NAME = RateTracking_dat_2,  
  FILENAME = 'D:\MKTG\RateTracking_2.ndf',    
  SIZE = 20MB,  
  MAXSIZE = 100MB,   
  FILEGROWTH = 10MB  
) TO FILEGROUP USERDATA; 
GO 
 
ALTER DATABASE RateTracking 
ADD FILEGROUP ARCHIVE; 
GO 
 
ALTER DATABASE RateTracking  
ADD FILE  
( NAME = RateTracking_dat_3,  
  FILENAME = 'D:\MKTG\RateTracking_3.ndf',    
  SIZE = 200MB,  
  MAXSIZE = 500MB,   
  FILEGROWTH = 50MB  
) TO FILEGROUP ARCHIVE; 
GO 
 
ALTER DATABASE RateTracking  
ADD FILE  
( NAME = RateTracking_dat_4,  
  FILENAME = 'D:\MKTG\RateTracking_4.ndf',    
  SIZE = 200MB,  
  MAXSIZE = 500MB,   
  FILEGROWTH = 50MB  
) TO FILEGROUP ARCHIVE; 
GO 

  Task 3: Change the default filegroup for the database 

1. Review the supplied requirements in the supporting documentation for the default filegroup. 

2. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

3. Enter the following statements and click Execute: 

USE master; 
GO 
 
ALTER DATABASE RateTracking MODIFY FILEGROUP USERDATA DEFAULT; 
GO 
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Exercise 3: Attach the OldProspects Database 

  Task 1: Copy the database files 

• In Windows Explorer, copy the files as specified below: 

Filename Source Folder Destination Folder 

OldProspects.mdf D:\10775A_Labs\10775A_04_PRJ D:\MKTG 

OldProspects.ldf D:\10775A_Labs\10775A_04_PRJ L:\MKTG 

  Task 2: Attach the database to the MKTG instance 

1. In Object Explorer, expand the Proseware server and expand Databases. 

2. Right-click Databases and click Attach. 

3. Click Add and navigate to the file D:\MKTG\OldProspects.mdf and click OK. 

4. Click the ellipsis beside the Current File Path for the log entry and navigate to the file 
L:\MKTG\OldProspects.ldf and click OK. 

5. Click OK to attach the database and note that OldProspects now appears in the list of databases in 
Object Explorer. 

Challenge Exercise 4: Add Multiple Files to tempdb (Only if time permits) 

  Task 1: Review the tempdb file requirements 

• In the Supporting Documentation review the tempdb Requirements From The Consultant section. 

  Task 2: Move existing files 

1. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

2. Enter the following statements and click Execute: 

USE master; 
GO 
 
ALTER DATABASE tempdb  
MODIFY FILE (NAME = tempdev, FILENAME = 'D:\MKTG\tempdb.mdf'); 
 
ALTER DATABASE tempdb  
MODIFY FILE (NAME = templog, FILENAME = 'L:\MKTG\templog.ldf'); 
GO 
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  Task 3: Add new files 

1. In Object Explorer expand the Proseware server, expand Databases, and expand System 
Databases. Right-click the master database and click New Query.  

2. Enter the following statements and click Execute: 

USE master; 
GO 
 
ALTER DATABASE tempdb  
 ADD FILE ( NAME = N'tempdev2',  
    FILENAME = N'D:\MKTG\tempdb_file2.ndf' ,  
    SIZE = 20MB,  
    FILEGROWTH = 10MB, 
    MAXSIZE = UNLIMITED ); 
     
ALTER DATABASE tempdb  
 ADD FILE ( NAME = N'tempdev3',  
    FILENAME = N'D:\MKTG\tempdb_file3.ndf' ,  
    SIZE = 20MB,  
    FILEGROWTH = 10MB, 
    MAXSIZE = UNLIMITED ); 
ALTER DATABASE tempdb  
 ADD FILE ( NAME = N'tempdev4',  
    FILENAME = N'D:\MKTG\tempdb_file4.ndf' ,  
    SIZE = 20MB,  
    FILEGROWTH = 10MB, 
    MAXSIZE = UNLIMITED ); 
GO 

  Task 4: Restart the server and check file locations 

1. Click Start, click All Programs, click Microsoft SQL Server 2012, click Configuration Tools, and 
then click SQL Server Configuration Manager.  

2. In the left-hand pane of the SQL Server Configuration Manager window, click SQL Server Services. 

3. In the right-hand pane, right-click the service SQL Server (MKTG) and click restart. 

4. In Object Explorer, right-click the tempdb database and click Properties. 

5. In the Database Properties – tempdb window, click Files in the Select a page pane. 

6. Make sure that the files listed match the requirements. 
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Module 5: Understanding SQL Server 2012 Recovery 
Models  

Lab 5: Understanding SQL Server Recovery 
Models 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project D:\10775A_Labs\10775A_05_PRJ 
\10775A_05_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Plan a Backup Strategy 

  Task 1: Review the business requirements 

• Review the supplied business requirements in the supporting documentation for the exercise. 

  Task 2: Determine an appropriate backup strategy for each database 

• There is no one correct answer. The options provided below are an example strategy that would 
meet the requirements. 

For the MarketDev database: Full Recovery Model 

Type of Backup Scheduled

Full  7:00pm Daily 

Log Every 20 minutes, starting at 8:20am 
and continuing till 6:00pm 

  

Notes:  

• Full database backup should complete in approximately 3.4 hours (20GB/100MB per minute). 
This means that you cannot employ only a full database backup strategy as it would not meet 
the RPO. The full database backup should complete by 10:24pm which is within the available 
time window for backups. 
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• Each log backup should complete in approximately 3.4 minutes (1GB per hour / 3 log backups 
per hour /100 MB per minute). This fits within the 20 minute interval and meets the RPO.  

• Full database restore should complete in approximately 4.3 hours (20GB/80MB per minute). 
Log file restore should complete in approximately 2.1 hours (10 hours * 1GB per hour /80MB 
per minute) and meets the RTO.  

 
For the Research database: Simple Recovery Model 

Type of Backup Scheduled 

Full 6:30pm Daily 

 

Notes:  

• Recovery to last full daily database backup complies with the RPO. 

• Daily backup should complete in approximately 2 minutes (200MB/100MB per minute). 

• Full restore should complete in approximately 2.5 minutes and complies with RTO 
(200MB/80MB per minute). 

Exercise 2: Configure Recovery Models 

  Task 1: Review and adjust the current database recovery models 

1. The recovery model for the MarketDev database is Simple and should be Full. Adjust the model by 
the following steps: 

1. In SSMS, in Object Explorer expand the Proseware server, right-click Databases and click 
Refresh. 

2. Expand Databases, right-click MarketDev and click Properties. 

3. In the Select a page pane, click Options. 

4. In the right hand pane, choose Full from the Recovery model drop down list and click OK. 

2. The recovery model for the Research database is correct and doesn’t need to be modified. 

Challenge Exercise 3: Review Recovery Models and Strategy (Only if time 
permits) 

  Task 1: Review the RPO and RTO requirements for the databases 

• The supporting documentation includes details of the business continuity requirements for the 
databases. You need to review this documentation. 

  Task 2: Review the existing recovery models and backup strategies 

• The supporting documentation also includes details of the backup strategy for the databases. You 
need to review this documentation. 
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  Task 3: Indicate whether or not the strategy would be successful 

1. For the CreditControl database, a Full backup would take approximately 3.4 hours (20GB/100MB 
per minute). This would not satisfy the requirements for the time window as the Wednesday 6am 
Full backup would not complete before office hours start. 

2. For the PotentialIssue database, the 15 minute log backups would meet the RPO. A Full restore 
should take approximately 24 minutes ((200MB + (7 days * 24 hours) * 10MB per hour) / 80MB per 
minute) which meets the RTO. The Full database backup would complete in approximately 2 
minutes (200MB/100MB per minute) which means that the Full database would complete in the 
available time window. The backup strategy for the PotentialIssue database meets the business 
requirements. 
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Module 6: Backup of SQL Server Databases  

Lab 6: Backup of SQL Server Databases 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project D:\10775A_Labs\10775A_06_PRJ 
\10775A_06_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Investigate Backup Compression 

  Task 1: Create a database backup without compression 

1. Using Windows Explorer create a new folder L:\SQLBackups. 

2. In Object Explorer, in SQL Server Management Studio, expand the Proseware server, expand 
Databases, right-click the MarketDev database, click Tasks, and click Back Up. 

3. In the Back Up Database – MarketDev window click Remove. 

4. In the Back Up Database – MarketDev window click Add. 

5. In the File name textbox type L:\SQLBackups\MarketDev_Full_Uncompressed.BAK and click 
OK. 

6. In the Select a page pane, click Options.  

7. In the Set backup compression drop-down list, click Do not compress backup, and click OK. 

8. In the Microsoft SQL Server Management Studio window click OK. 

  Task 2: Create a database backup with compression 

1. In Object Explorer, right-click the MarketDev database, click Tasks, and click Back Up. 

2. In the Back Up Database – MarketDev window click Remove. 

3. In the Back Up Database – MarketDev window click Add. 

4. In the File name textbox type L:\SQLBackups\MarketDev_Full_Compressed.BAK and click OK. 
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5. In the Select a page pane, click Options.  

6. In the Set backup compression drop-down list, click Compress backup, and click OK. 

7. In the Microsoft SQL Server Management Studio window click OK. 

  Task 3: Compare the file sizes created 

1. In Windows Explorer, navigate to the folder L:\SQLBackups and note the size of the compress and 
uncompressed backup files. 

2. Calculate the space savings provided by compression as: 

SpaceSavings=(Uncompressed size–Compressed size)*100/Uncompressed size 

Note A typical value would be (233-66)*100/233 = 72% saving. 

Exercise 2: Transaction Log Backup 

  Task 1: Execute a script to introduce workload to the MarketDev database 

1. In Solution Explorer, double-click the file 61 – Workload File.sql to open it. 

2. On the Toolbar click Execute. 

  Task 2: Backup the transaction log on the MarketDev database 

1. In Object Explorer, right-click the MarketDev database, click Tasks, and click Back Up. 

2. In the Back Up Database – MarketDev window click Remove. 

3. In the Back Up Database – MarketDev window click Add. 

4. In the File name textbox type L:\SQLBackups\MarketDev_Log_Compressed.BAK and click OK. 

5. From the Backup type drop-down list box, select Transaction Log. 

6. In the Select a page pane, click Options.  

7. In the Set backup compression drop-down list, click Compress backup, and click OK. 

8. In the Microsoft SQL Server Management Studio window click OK. 

Exercise 3: Differential Backup 

  Task 1: Execute a script to introduce workload to the MarketDev database 

1. In Solution Explorer, double-click the file 61 – Workload File.sql to open it. 

2. On the Toolbar click Execute. 

  Task 2: Create a differential backup of the MarketDev database 

1. In Object Explorer, right-click the MarketDev database, click Tasks, and click Back Up. 

2. In the Back Up Database – MarketDev window click Remove. 

3. In the Back Up Database – MarketDev window click Add. 
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4. In the File name textbox type L:\SQLBackups\MarketDev_Differential_Compressed.BAK and 
click OK. 

5. From the Backup type drop-down list box, select Differential. 

6. In the Select a page pane, click Options.  

7. In the Set backup compression drop-down list, click Compress backup, and click OK. 

8. In the Microsoft SQL Server Management Studio window click OK. 

9. Using Windows Explorer, note the size of the differential backup L:\SQLBackups 
\MarketDev_Differential_Compressed.BAK compared to the full backup 
L:\SQLBackups\MarketDev_Full_Compressed.BAK. 

Note A typical value for the Differential backup size would be 240KB. A typical value for 
the Full backup size would be 66 MB. 

  Task 3: Execute a script to introduce workload to the MarketDev database 

1. In Solution Explorer, double-click the file 71 – Workload File.sql to open it. 

2. On the Toolbar click Execute. 

  Task 4: Append a differential backup to the previous differential backup file 

1. In Object Explorer, right-click the MarketDev database, click Tasks, and click Back Up. 

2. Ensure that the Destination shows L:\SQLBackups\MarketDev_Differential_Compressed.BAK. 

3. From the Backup type drop-down list box, select Differential. 

4. In the Select a page pane, click Options.  

5. In the Overwrite media option ensure that Append to the existing backup set is selected. 

6. In the Set backup compression drop-down list, click Compress backup, and click OK. 

7. In the Microsoft SQL Server Management Studio window click OK. 

8. Using Windows Explorer, note that the size of the Differential backup has increased. The file now 
contains two backups. 

Note A typical value for the backup file size would be 54 MB. 

Exercise 4: Copy-only Backup 

  Task 1: Create a copy-only backup of the MarketDev database, ensuring to choose to 
verify the backup 

1. In Object Explorer, right-click the MarketDev database, click Tasks, and click Back Up. 

2. In the Back Up Database – MarketDev window click Remove. 

3. In the Back Up Database – MarketDev window click Add. 

4. In the File name textbox type L:\SQLBackups\MarketDev_Copy_Compressed.BAK and click OK. 
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5. From the Backup type drop-down list box, select Full. 

6. Ensure that Copy-only Backup is checked. 

7. In the Select a page pane, click Options.  

8. In the Overwrite media options, select Back up to a new media set, and erase all existing 
backup sets. 

9. In the New media set name text box, type MarketDev Copy Backup. 

10. In the New media set description text box, type MarketDev Copy Backup for Integration 
Team. 

11. In the Reliability options, ensure that Verify backup when finished is checked. 

12. In the Set backup compression drop-down list, click Compress backup, and click OK. 

13. In the Microsoft SQL Server Management Studio window click OK. 

14. Using Windows Explorer, note the size of the Copy backup compared to the Full backup. 

Challenge Exercise 5: Partial Backup (Only if time permits) 

  Task 1: Perform a backup of the read-write filegroups on the RateTracking database 

1. In Solution Explorer, double-click the file 91 – Lab Exercise 5.sql to open it. 

2. Review the script. 

3. On the Toolbar click Execute. 
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Module 7: Restoring SQL Server 2012 Databases  

Lab 7: Restoring SQL Server 2012 
Databases 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_07_PRJ\10775A_07_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Note The setup script for this module is intended to throw an error regarding missing 
files this is normal. 

Exercise 1: Determine a Restore Strategy 

  Task 1: Review the backups contained within the backup file 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1 Task 1.sql to open it. 

2. Review the script. 

3. On the Toolbar click Execute. 

4. The BackUpTypeDescription contained in the file are (in order): 

a. Database 

b. Database 

c. Database Differential 

d. Transaction Log 

e. Database Differential 

f. Transaction Log 

g. Transaction Log 
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  Task 2: Determine how the restore should be performed 

1. Restoring a database requires: 

• Latest full database backup (File 2) 

• Most recent differential backup (File 5) 

• All log file backups since the latest differential backup (Files 6,7) 

2. With NORECOVERY should be specified on all restores. 

Exercise 2: Restore the Database 

  Task 1: Restore the database 

1. In Object Explorer, expand the Proseware server, right-click Databases, and click Restore 
Database. 

2. In the Source options, click Device then click on the ellipsis button to the right hand side of the 
Device textbox. 

3. In the Select backup devices window, click Add. 

4. Navigate to the file D:\MSSQLServer\MarketYields.bak and click OK. 

5. In the Select backup devices window, click OK. 

6. In the Restore Database - MarketYields window, in the Select a page pane, click Files. 

7. In the Restore database files as options, check Relocate all files to folder. 

8. In the Select a page pane, click Options. 

9. From the Recovery state dropdown, select RESTORE WITH STANDBY. 

10. In the Standby file textbox, type L:\MKTG\Log_Standby.bak and click OK. 

Note If the OK button is not visible you will need to scroll to the bottom of the window, 
or increase the resolution of your screen. 

11. In the Microsoft SQL Server Management Studio window, click OK. 

12. In Object Explorer expand the Proseware server, expand Databases, right-click Databases and 
click Refresh. 

13. The MarketYields database should show as Standby / Read-Only. 
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Challenge Exercise 3: Using STANDBY Mode (Only if time permits) 

  Task 1: Execute queries against the STANDBY database to ensure it is accessible 

1. In Object Explorer, right-click Proseware server, and click New Query. 

2. Type the following query as shown in the snippet below: 

SELECT * FROM MarketYields.dbo.LogData; 

3. On the Toolbar click Execute. 

Note 25000 rows should be returned. 

4. Close the query window. (If prompted to Save changes click No). 

  Task 2: Restore another log file, leaving the database in STANDBY mode 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click the MarketYields 
database and click Tasks, click Restore, click Transaction Log. 

2. In the Restore source options, click From file or tape, click the ellipsis button at the right hand 
side of the From file or tape textbox. 

3. In the Select backup devices window, click Add. 

4. Navigate to the file D:\MSSQLSERVER\MarketYields_log.bak and click OK. 

5. In the Select backup devices window, click OK. 

6. In the Select a page pane, click Options. 

7. In the Recovery state options select Leave the database in read-only mode. 

8. In the Standby file textbox, type L:\MKTG\Log_Standby.bak and click OK. 

9. In the Microsoft SQL Server Management Studio window, click Yes. 

10. In the Microsoft SQL Server Management Studio window, click OK. 

11. In Object Explorer expand the Proseware server, expand Databases, right-click Databases and 
click Refresh. 

12. The MarketYields database should show as Standby / Read-Only. 
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Module 8: Importing and Exporting Data  

Lab 8: Importing and Exporting Data 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_08_PRJ\10775A_08_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Import the Excel Spreadsheet 

  Task 1: Import the data using the Import Wizard 

1. In SQL Server Management Studio, in Object Explorer, expand the Proseware server, expand 
Databases, right-click the MarketDev database, click Tasks, and click Import Data. 

2. In the SQL Server Import and Export Wizard window, click Next. 

3. In the Choose a Data Source window, select Microsoft Excel from the Data source drop-down list, 
and click Browse. 

4. Navigate to the file D:\10775A_Labs\10775A_08_PRJ\10775A_08_PRJ\Currency.xls and click 
Open. 

5. In the Choose a Data Source window, make sure that the First row has column names checkbox is 
checked, and click Next.  

6. In the Choose a Destination window, make sure that the Server name is Proseware and the 
Database name is MarketDev, and click Next. 

7. In the Specify Table Copy or Query window, click Next. 

8. In the Select Source Tables and Views window, check the checkbox beside `Currency`, change the 
Destination to [DirectMarketing].[Currency] and click Edit Mappings. 

9. In the Column Mappings window.  

a. Change the Type for the CurrencyID row to int. 

b. Uncheck the Nullable column in each row. 

c. Change the Size for the CurrencyCode to 3. 

d. Change the Size for the CurrencyName to 50 and click OK. 
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10. In the Select Source Tables and Views window, click Next. 

11. In the Review Data Type Mapping window, click Next. 

12. In the Save and Run Package window, click Next. 

13. In the Complete the Wizard window, click Finish. 

Note One warning about potential data truncation may occur. This is normal. 

14. In the Execution is completed window, click Close.  

15. In Object Explorer, right-click the MarketDev database and click New Query. 

16. Type the code as shown in the snippet below: 

SELECT * FROM DirectMarketing.Currency; 

17. On the Toolbar, click Execute. 

Note 105 currencies should be returned. 

Exercise 2: Import the CSV File 

  Task 1: Import the CSV file 

1. In Solution Explorer, double-click the file 61 – Lab Exercise 2.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

4. Wait for the query to complete and record the duration of the query. (The duration of the query is 
shown on the bottom right-hand side of the Status bar). 

Note A typical execution time on the VM would be approximately 3 minutes. 

Exercise 3: Create and Test an Extraction Package 

  Task 1: Create and test an extraction package 

1. In SQL Server Management Studio, in Object Explorer, expand the Proseware server, expand 
Databases, right-click the MarketDev database, click Tasks, and click Export Data. 

2. In the SQL Server Import and Export Wizard window, click Next. 

3. In the Choose a Data Source window, click Next. 

4. In the Choose a Destination window, in the Destination drop down list, choose Flat File 
Destination. 

In the File name text box type the following location:D:\MKTG\ProspectsToContact.csv. 

5. Make sure that the Column names in the first data row checkbox is checked and click Next. 
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6. In the Specify Table Copy or Query window, click Write a query to specify the data to transfer, 
and click Next. 

7. In the Provide a Source Query window, type the code as shown in the snippet below, and click 
Parse: 

SELECT ProspectID, FirstName, LastName, CellPhoneNumber, 
WorkPhoneNumber,EmailAddress, LatestContact 
FROM Marketing.Prospect 
WHERE LatestContact < DATEADD(MONTH,-1,SYSDATETIME()) 
OR LatestContact IS NULL 
ORDER BY ProspectID; 

8. In the SQL Server Import or Export Wizard window, make sure that the parsing succeeded and click 
OK. 

9. In the Provide a Source Query window, click Next. 

10. In the Configure Flat File Destination window, click Next. 

11. In the Save and Run Package window, make sure that Run immediately and Save SSIS Package 
checkboxes are checked, and that SQL Server option button is selected, and click Next. 

12. In the Save SSIS Package window, type Weekly Extract of Prospects to Contact in both the Name 
and Description textboxes, and click Next. 

13. In the Complete the Wizard window, click Finish. 

Note One warning about potential data truncation and one error if the table does not 
already exist may occur. This is normal. 

14. In the Execution is completed window, click Close.  

Challenge Exercise 4: Compare Loading Performance (Only if time 
permits) 

  Task 1: Re-execute load with indexes disabled 

1. In Solution Explorer, double-click the file 81 – Lab Exercise 4.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

4. Wait for the query to complete and record the duration of the query. (The duration of the query is 
shown on the bottom right-hand side of the Status bar). 

Note A typical execution time on the VM would be approximately 1.2 minutes. 
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Module 9: Authenticating and Authorizing Users  

Lab 9: Authenticating and Authorizing 
Users 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_09_PRJ\10775A_09_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Create Logins 

  Task 1: Review the requirements 

• Review the supplied security requirements in the supporting documentation. Determine the 
required Windows logins, Windows group logins and SQL logins. 

  Task 2: Create the required logins 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Exercise 2: Correct an Application Login Issue 

  Task 1: Correct an Application Login Issue 

1. In Solution Explorer, double-click the file 61 – Lab Exercise 2.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 
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Exercise 3: Create Database Users 

  Task 1: Review the requirements 

• Review the supplied security requirements in the supporting documentation. Determine the 
required Windows logins, Windows group logins and SQL logins. 

  Task 2: Create the required database users 

1. In Solution Explorer, double-click the file 71 – Lab Exercise 3.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Challenge Exercise 4: Correct Access to Restored Database (Only if time 
permits) 

  Task 1: Correct Access to a Restored Database 

1. In Solution Explorer, double-click the file 81 – Lab Exercise 4.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 
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Module 10: Assigning Server and Database Roles  

Lab 10: Assigning Server and Database 
Roles 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_10_PRJ\10775A_10_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Assign Server Roles 

  Task 1: Review the requirements 

• Review the supplied security requirements in the supporting documentation.  

  Task 2: Assign any required server roles 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Exercise 2: Assign Fixed Database Roles 

  Task 1: Review the requirements 

• Review the supplied security requirements in the supporting documentation.  

  Task 2: Assign any required fixed database roles 

1. In Solution Explorer, double-click the file 61 – Lab Exercise 2.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 
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Exercise 3: Create and Assign User-defined Database Roles 

  Task 1: Review the requirements 

• Review the supplied security requirements in the supporting documentation.  

  Task 2: Create and assign any required user-defined database roles 

1. In Solution Explorer, double-click the file 71 – Lab Exercise 3.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Challenge Exercise 4: Check Role Assignments (Only if time permits) 

  Task 1: Check the role assignments for Darren Parker 

1. In Solution Explorer, double-click the file 81 – Lab Exercise 4.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 
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Module 11: Authorizing Users to Access Resources  

Lab 11: Authorizing Users to Access 
Resources 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_11_PRJ\10775A_11_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Assign Schema-level Permissions 

  Task 1: Review the security requirements that have been updated from the previous 
module 

1. Review the supplied security requirements in the supporting documentation. 

2. Determine the permissions that should be assigned at the schema level. (Note: that a sample 
solution is shown in Task 2). 

  Task 2: Assign the required permissions 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Exercise 2: Assign Object-level Permissions 

  Task 1: Review the security requirements  

1. Review the supplied security requirements in the supporting documentation. 

2. Determine the permissions that should be assigned at the object level. (Note: that a sample solution 
is shown in Task 2). 
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  Task 2: Assign the required permissions 

1. In Solution Explorer, double-click the file 61 – Lab Exercise 2.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Challenge Exercise 3: Test Permissions (Only if time permits) 

  Task 1: Design and execute a test 

1. In Solution Explorer, double-click the file 71 – Lab Exercise 3a.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

4. In Solution Explorer, double-click the file 72 – Lab Exercise 3b.sql to open it. 

5. Review the T-SQL script. 

6. On the Toolbar click Execute. 

Note An error is returned as April.Reagan does not have permission to select the rows 
from the DirectMarketing.Competitor table. 
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Module 12: Auditing SQL Server Environments  

Lab 12: Auditing SQL Server Environments 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_12_PRJ\10775A_12_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Determine Audit Configuration and Create Audit 

  Task 1: Review the requirements 

• Review the supplied requirements in the supporting documentation for the exercise, noting 
requirements that relate to server audits. 

  Task 2: Create the server audit 

1. Determine the configuration of the required server audit. 

2. Using Windows Explorer, create a folder C:\Audit. 

3. Using Windows Explorer, create a folder C:\Audit\AuditLog. 

4. In Object Explorer, expand the Proseware server, and expand Security. 

5. Right-click Audits and click New Audit. 

6. In the Create Audit window, type Proseware Compliance Audit in the Audit name textbox. 

7. In the Queue delay (in milliseconds) textbox, type 2000. 

8. For Audit Log Failure, select the Shut down server option. 

9. In the File path textbox, type C:\Audit\AuditLog. 

10. Uncheck the Unlimited checkbox for Maximum file size. 

11. In the Maximum file size drop-down list type 1. 
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12. Click the GB option button for Maximum file size and click OK. 

13. In Object Explorer, expand Audits, right-click Proseware Compliance Audit and click Enable 
Audit. 

14. In the Enable Audit window, click Close. 

Exercise 2: Create Server Audit Specifications 

  Task 1: Review the requirements 

• Review the supplied requirements in the supporting documentation for the exercise, noting 
requirements that relate to server audit specifications. 

  Task 2: Create the server audit specifications 

1. Determine the configuration of the required server audit specifications. 

2. In Object Explorer, right-click Server Audit Specifications, and click New Server Audit 
Specification. 

3. In the Create Server Audit Specification window, type Proseware Compliance Server Audit 
Specification in the Name textbox. 

4. From the Audit drop-down list, select Proseware Compliance Audit. 

5. In the Actions list, in row 1, click the Audit Action Type drop-down, and click 
FAILED_LOGIN_GROUP. 

6. In the Actions list, in row 2, click the Audit Action Type drop-down, and click 
SERVER_PRINCIPAL_CHANGE_GROUP. 

7. In the Actions list, in row 3, click the Audit Action Type drop-down, and click 
SERVER_ROLE_MEMBER_CHANGE_GROUP. 

8. In the Actions list, in row 4, click the Audit Action Type drop-down, and click 
LOGIN_CHANGE_PASSWORD_GROUP,  and click OK. 

9. In Object Explorer, expand Server Audit Specifications, right-click Proseware Compliance Server 
Audit Specification, and click Enable Server Audit Specification. 

10. In the Enable Server Audit Specification window, click Close. 

Exercise 3: Create database audit specifications 

  Task 1: Review the requirements 

• Review the supplied requirements in the supporting documentation for the exercise, noting 
requirements that relate to database audit specifications. 

  Task 2: Create the database audit specifications 

1. Determine the configuration of the required database audit specifications. 

2. In Object Explorer, expand the Proseware server, expand Databases, expand the MarketDev 
database, expand Security, and expand Database Audit Specifications. 

3. Right-click Database Audit Specifications, and click New Database Audit Specifications. 
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4. In the Create Database Audit Specification window, type Proseware Compliance MarketDev 
Audit Specification in the Name textbox. 

5. From the Audit drop-down list, select Proseware Compliance Audit. 

6. In the Actions list, in row 1, click the Audit Action Type drop-down, and click 
BACKUP_RESTORE_GROUP. 

7. In the Actions list, in row 2, click the Audit Action Type drop-down, and click 
DATABASE_OWNERSHIP_CHANGE_GROUP. 

8. In the Actions list, in row 3, click the Audit Action Type drop-down, and click 
DATABASE_PERMISSION_CHANGE_GROUP. 

9. In the Actions list, in row 4, click the Audit Action Type drop-down, and click 
DATABASE_PRINCIPAL_CHANGE_GROUP. 

10. In the Actions list, in row 5, click the Audit Action Type drop-down, and click 
DATABASE_ROLE_MEMBER_CHANGE_GROUP. 

11. In the Actions list, in row 6, click the Audit Action Type drop-down, and click EXECUTE.  

12. In row 6, click the Object Class drop-down list and click OBJECT.  

13. In row 6, click the ellipsis in the Object Name column. 

14. In the Select Objects window, click Browse. 

15. In the Matching Objects pane, check the box beside [Marketing].[MoveCampaignBalance], and 
click OK. 

16. In the Select Objects window, click OK. 

17. In row 6, click the ellipsis in the Principal Name column. 

18. In the Select Objects window, click Browse. 

19. In the Matching Objects pane, check the box beside [public], and click OK. 

20. In the Select Objects window, click OK. 

21. In the Actions list, in row 7, click the Audit Action Type drop-down, and click UPDATE. 

22. In row 7, click the Object Class drop-down list and click OBJECT.  

23. In row 7, click the ellipsis in the Object Name column. 

24. In the Select Objects window, click Browse. 

25. In the Matching Objects pane, check the box beside [Marketing].[CampaignBalance], and click 
OK. 

26. In the Select Objects window, click OK. 

27. In row 7, click the ellipsis in the Principal Name column. 

28. In the Select Objects window, click Browse. 

29. In the Matching Objects pane, check the box beside [public], and click OK. 

30. In the Select Objects window, click OK. 
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31. In the Create Database Audit Specification window, click OK. 

32. In Object Explorer, right-click Proseware Compliance MarketDev Audit Specification and click 
Enable Database Audit Specification. 

33. In the Enable Database Audit Specification window, click Close. 

Challenge Exercise 4: Test Audit Functionality (Only if time permits) 

  Task 1: Execute the workload script 

1. In Solution Explorer, double-click the file 81 – Lab Exercise 4a.sql to open it. 

2. Review the T-SQL script. Note any actions that you would expect to be audited. In Task 2 you will 
see the actual list of audited actions. 

3. On the Toolbar click Execute. 

  Task 2: Review the captured audit details  

1. In Object Explorer, expand the Proseware server, expand Security, expand Audits. 

2. Right-click the Proseware Compliance Audit, and click View Audit Logs. 

3. In the Log File Viewer –  Proseware window, review the captured events and compare them to your 
list of expected events from Task 1.  

Note Make sure you scroll to the list of events to the right to see all available columns. 

4. In the Log File Viewer –  Proseware window click Close. 

5. In Solution Explorer, double-click the file 82 – Lab Exercise 4b.sql to open it. 

6. Review the T-SQL script.  

7. On the Toolbar click Execute. A list of audited events will be returned. 
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Module 13: Automating SQL Server 2012 Management  

Lab 13: Automating SQL Server 
Management 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_13_PRJ\10775A_13_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Create a Data Extraction Job 

  Task 1: Create the required job 

1. In Object Explorer, expand the Proseware server, expand SQL Server Agent, right-click Jobs and 
click New Job.  

2. In the New Job window, in the Name textbox type Extract Uncontacted Prospects. 

3. In the Select a page pane, click Steps, and then click New. 

4. In the Step name textbox, type Execute Prospect Extraction Package. 

5. From the Type drop-down list, select SQL Server Integration Services Package. 

6. In the General tab, from the Package source drop-down, select SQL Server. 

7. In the Server textbox type Proseware, and click the ellipsis beside the Package textbox. 

8. In the Select an SSIS Package window, click Weekly Extract of Prospects to Contact and click OK. 

9. In the New Job Step window, click OK. 

10. In the New Job window, click OK. 
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  Task 2: Test that the job executes without error 

1. In Object Explorer, expand the Proseware server, expand SQL Server Agent, and expand Jobs. 

2. Right-click Jobs and click Refresh. 

3. Right-click Extract Uncontacted Prospects, and click Start Job at Step. 

4. In the Start Jobs - Proseware window, make sure that the job succeeds and click Close. 

Exercise 2: Schedule the Data Extraction Job  

  Task 1: Schedule the data extraction job 

1. In Object Explorer, expand the Proseware server, expand SQL Server Agent, and expand Jobs. 

2. Right-click Jobs and click Refresh. 

3. Right-click Extract Uncontacted Prospects, and click Properties. 

4. On the Select a page pane, click Schedules, and then click New. 

5. In the New Job Schedule window, in the Name textbox type Each Monday Morning at 8:30AM. 

6. Check the Monday checkbox; uncheck the Sunday checkbox. 

7. In the Occurs once at textbox, change the time to 8:30:00AM and press the Tab key.  Note the 
contents of the Description textbox and click OK. 

8. In the Job Properties – Extract Uncontacted Prospects window, click New. 

9. In the New Job Schedule window, in the Name textbox type Each Tuesday Evening at 6:30PM. 

10. Check the Tuesday checkbox; uncheck the Sunday checkbox. 

11. In the Occurs once at textbox, change the time to 6:30:00PM and hit the Tab key. Note the 
contents of the Description textbox and click OK. 

12. In the Job Properties – Extract Uncontacted Prospects window, click OK. 

Challenge Exercise 3: Troubleshoot a Failing Job (Only if time permits) 

  Task 1: Troubleshoot the failing job 

1. In Object Explorer, expand the Proseware server, expand SQL Server Agent, and expand Jobs. 

2. Right-click Jobs and click Refresh. 

3. Right-click Extract Long Page Loads, and click View History. 

4. In the Log File Viewer – Proseware window, click the plus sign in a row that has a failing execution 
to expand the job steps. Note that step ID 2 has failed.  

5. Click on the row for step ID 2, and scroll through the Selected row details pane to find the error. 
Note that the error is caused by a reference to an invalid object name 
Marketing.RecentLongPageLoads.  

6. Click Close to close the Log File Viewer – Proseware window. 

7. Right-click Extract Long Page Loads, and click Properties. 

8. In the Select a page pane, click Steps. 
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9. In the Job step list, click the row for Step 2 and click Edit. 

10. Review the command that is being executed and note that Marketing.RecentLongPageLoads 
appears to be a table or view that the web log rows are being inserted into.  

11. In Object Explorer, expand Databases, expand MarketDev, and expand Tables. Note that the 
name of the table should be Marketing.RecentLongPageLoad. 

12. In the Job Step Properties – Copy Recent Long Page Loads window change the name of the table in 
the Command textbox from Marketing.RecentLongPageLoads to 
Marketing.RecentLongPageLoad and click OK. 

13. In the Job Properties – Extract Long Page Loads window, click OK.  

14. In Object Explorer, right-click the Extract Long Page Loads job and click Start Job at Step. 

15. In the Start Job on ‘Proseware’ window, click Start. 

16. In the Start Job on ‘Proseware’ window, make sure the job executed successfully and click Close. 

17. In Object Explorer, right-click Extract Long Page Loads, and click Properties. 

18. In the Select a page pane, click Schedules and note the difference between the name of the 
schedule and the description of the schedule, then click Edit. 

19. From the Occurs drop-down list box, click Weekly. 

20. Check the Monday checkbox and review the remaining settings, then click OK. 

21. In the Schedule list, note that the schedule name now relates to the schedule description. 

22. In the Job Properties – Extract Long Page Loads window, click OK.  
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Module 14: Configuring Security for SQL Server Agent  

Lab 14: Configuring Security for SQL Server 
Agent 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_14_PRJ\10775A_14_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Troubleshoot Job Execution Failure 

  Task 1: Troubleshoot job execution failure 

1. Review the previous actions taken by Terry Adams as detailed in the supporting documentation for 
the exercise. 

2. In Object Explorer, expand the Proseware server, expand SQL Server Agent, expand Jobs,  
right-click Extract Uncontacted Prospects and click View History. 

3. In the Log File Viewer - Proseware window, click the plus sign in a failing row to expand the job 
steps. 

4. Click the row for Step ID 1. In the Selected row details pane, scroll the pane until you locate the 
error.  

Note The error indicates that Non-SysAdmins have been denied permission to run DTS 
Execution job steps without a proxy account. The step failed. 

5. You have determined that a proxy account is needed for the job step. Close the  
Log File Viewer - Proseware window. 
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Exercise 2: Resolve the Security Issue 

  Task 1: Create and assign proxy account 

1. In Object Explorer, expand the Proseware server, expand Security, and expand Credentials. 

2. Right-click Credentials and click New Credential. 

3. In the New Credential window, in the Credential name text box, type ExtractIdentity. 

4. In the Identity textbox, type MIA-SQL1\ExtractUser. 

5. In the Password and Confirm password textboxes, type Pa$$w0rd, and click OK. 

6. In Object Explorer, expand SQL Server Agent, right-click Proxies, and click New Proxy. 

7. In the New Proxy Account window, in the Proxy name textbox, type ExtractionProxy. 

8. In the Credential name textbox, type ExtractIdentity. 

9. In the Active to the following subsystems list, check the box beside SQL Server Integration 
Services Package. 

10. In the Select a page pane, click Principals, and click Add. 

11. In the Available principals list, check the box beside PromoteApp login, and click OK. 

12. In the New Proxy Account window, click OK. 

13. In Object Explorer, expand Jobs, right-click Extract Uncontacted Prospects and click Properties. 

14. In the Job Properties - Extract Uncontacted Prospects window, in the Select a page pane click 
Steps, then click Edit. 

15. In the Run as drop-down list, click ExtractionProxy, and click OK. 

16. In the Job Properties - Extract Uncontacted Prospects window, click OK. 

  Task 2: Test to see if all problems have been resolved 

1. In Object Explorer, right-click the Extract Uncontacted Prospects job, and click Start Job at Step. 

2. In the Start Jobs - Proseware window, note that the job still fails, and click Close. 

3. In Object Explorer, right-click the Extract Uncontacted Prospects job, and click View History. 

4. In the Log File Viewer - Proseware window, click the plus sign beside the top entry in the list to 
expand the job steps. 

5. Click in the row for Step ID 1, in the Selected row details pane, scroll down to find the error. 

Note A SQL Statement is now failing because of a login issue. 

6. You have resolved the original problem. If you have time you should continue to Exercise 3 to 
resolve the remaining problem. 
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Challenge Exercise 3: Perform Further Troubleshooting (Only if time 
permits) 

  Task 1: Perform further troubleshooting 

1. In the Log File Viewer -  Proseware window, in the Select row details pane, read the detail of the 
error message, determine the cause of the error and close the window. 

Note The most important error is Login failed for user ‘MIA-SQL1\ExtractUser’. Even 
though a Windows credential is required for the SSIS job to access the file system to write 
the extracted file, the credential also needs to be able to connect to SQL Server to retrieve 
the data from the Marketing.Prospects table. You need to create a login for the Windows 
user, create a database user for the login and then assign SELECT permission on the 
Marketing.Prospects table to the credential. 

2. In Solution Explorer, double-click the file 71 – Lab Exercise 3.sql to open it. 

3. Review the T-SQL script. 

4. On the Toolbar click Execute. 

5. In Object Explorer, right-click the Extract Uncontacted Prospects job, and click Start Job at Step. 

7. In the Start Jobs - Proseware window, note that the job still fails, and click Close. 

8. In Object Explorer, right-click the Extract Uncontacted Prospects job, and click View History. 

9. In the Log File Viewer - Proseware window, click the plus sign beside the top entry in the list to 
expand the job steps. 

10. Click in the row for Step ID 1, in the Selected row details pane, scroll down to find the error. 

Note ExtractUser does not have permissions on the D:\MKTG folder. 

11. In Windows Explorer, navigate to the folder D:\MKTG, right-click the MKTG folder and click 
Properties. 

12. In the MKTG Properties window, click on the Security tab, click Edit. 

13. In the Permissions for MKTG window, click Add. 

14. In the Select Users, Computers, Services Accounts, or Groups window, in the Enter the object 
names to select textbox type MIA-SQL1\ExtractUser and click OK. 

15. In the Permissions for MKTG window, check the Allow checkbox for the Modify row and click OK. 

16. In the MKTG Properties window, click OK. 

17. In Object Explorer, right-click the Extract Uncontacted Prospects job, and click Start Job at Step. 

18. In the Start Jobs - Proseware window, note that the job now completes successfully, and click Close. 
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Module 15: Monitoring SQL Server 2012 with Alerts and 
Notifications  

Lab 15: Monitoring SQL Agent Jobs with 
Alerts and Notifications 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_15_PRJ\10775A_15_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Configure Database Mail 

  Task 1: Configure database mail 

1. Review the database mail configuration parameters in the supporting documentation for the 
exercise. 

2. In Object Explorer, expand the Proseware server, expand Management, right-click Database Mail, 
and click Configure Database Mail. 

3. In the Welcome to Database Mail Configuration Wizard window, click Next.  

4. In the Select Configuration Task window, click Next.  

5. In the Microsoft SQL Server Management Studio window, click Yes.  

6. In the New Profile window, in the Profile name textbox type Proseware SQL Server Agent 
Profile, and click Add.  

7. In the New Database Mail Account window, in the Account name textbox, type Proseware 
Administrator.  

8. In the E-mail address textbox, type prosewaresqladmin@adventureworks.com.  

9. In the Display name textbox, type Proseware SQL Server Administrator.  

10. In the Reply e-mail textbox, type prosewaresqladmin@adventureworks.com.  

11. In the Server name textbox type mailserver.adventureworks.com, and click OK.  
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12. In the New Profile window, click Add.  

13. In the New Database Mail Account window, in the Account name textbox, type AdventureWorks 
Administrator.  

14. In the E-mail address textbox, type adventureworkssqladmin@adventureworks.com.  

15. In the Display name textbox, type AdventureWorks SQL Server Administrator.  

16. In the Reply e-mail textbox, type adventureworkssqladmin@adventureworks.com.  

17. In the Server name textbox type mailserver.adventureworks.com, and click OK.  

18. In the New Profile window, click Next. 

19. In the Manage Profile Security window, check the box in the Public column and change the value 
in the Default Profile column to Yes. 

20. Click on the Private Profiles tab, and from the User name drop-down list, select 
ADVENTUREWORKS\pwservice. 

21. Check the box in the Access column, and change the value in the Default Profile column to Yes, 
then click Next. 

22. In the Configure System Parameters window, change the Maximum File Size (Bytes) to 4194304, 
and click Next. 

23. In the Complete the Wizard window, click Finish.  

24. In the Configuring window, click Close. 

  Task 2: Test that database mail operates 

1. In Object Explorer, right-click Database Mail and click Send Test E-Mail. 

2. In the Send Test E-Mail from MIA-SQL1\MKTG window, in the To textbox type 
prosewaresqladmin@adventureworks.com, and click Send Test E-Mail. 

3. In the Database Mail Test E-Mail window, note the description and click OK. 

4. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

5. Review the T-SQL script. 

6. On the Toolbar click Execute. 

Note An email with the subject Database Mail Test should be returned by the query. 

Exercise 2: Implement Notifications 

  Task 1: Review the requirements 

• Review the supplied requirements in the supporting documentation for the exercise. In particular, 
note any required operators. 
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  Task 2: Configure the required operators 

1. In Object Explorer, expand SQL Server Agent, right-click Operators and click New Operator. 

2. In the New Operator window, in the Name textbox, type IT Support Fail-safe Operator. 

3. In the Pager e-mail name, type itsupport.pager@adventureworks.com. 

4. In the Pager on duty schedule, check Monday, Tuesday, Wednesday, Thursday, Friday, 
Saturday, and Sunday. Change the Workday begin time to 12:00:00 AM and Workday end to 
11:59:59 PM for every row, and click OK. 

5. In Object Explorer, right-click Operators and click New Operator. 

6. In the New Operator window, in the Name textbox, type Jeff Hay. 

7. In the Pager e-mail name, type jeff.hay.pager@adventureworks.com. 

8. In the Pager on duty schedule, check Monday, Tuesday, Wednesday, Thursday, Friday, 
Saturday, and Sunday. Change the Workday begin time to 12:00:00 AM and Workday end to 
11:59:59 PM for every row, and click OK. 

9. In Object Explorer, right-click Operators and click New Operator. 

10. In the New Operator window, in the Name textbox, type Palle Petersen. 

11. In the Pager e-mail name, type palle.petersen.pager@adventureworks.com. 

12. In the Pager on duty schedule, check Monday, Tuesday, Wednesday, Thursday, Friday, 
Saturday, and Sunday. Change the Workday begin time to 12:00:00 AM and Workday end to 
11:59:59 PM for every row, and click OK. 

  Task 3: Configure SQL Server Agent Mail 

1. In Object Explorer, right-click SQL Server Agent, and click Properties.  

2. In the Select a page pane click Alert System. In the Mail session options, click Enable mail 
profile.  

3. From the Mail profile drop-down list, select Proseware SQL Server Agent Profile. 

4. In the Fail-safe operator options, check Enable fail-safe operator. 

5. In the Operator drop-down list, select IT Support Fail-safe Operator. 

6. In the Notify using options, check Pager, and click OK. 

7. In Object Explorer, right-click SQL Server Agent and click Restart. 

8. In the SQL Server Management Studio window, click Yes. 

  Task 4: Configure and Test Notifications in SQL Server Agent Jobs 

1. In Object Explorer, expand SQL Server Agent, expand Jobs, right-click Backup Log TestAlertDB 
and click Properties. 

2. In the Select a page pane, click Notifications. 

3. In the Actions to perform when the job completes option, check Page. 

4. In the Page drop-down list, select Jeff Hay.  
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5. In the Page actions drop-down list, select When the job completes, and click OK. 

6. In Object Explorer, right-click Job that Fails and click Properties. 

7. In the Select a page pane, click Notifications. 

8. In the Actions to perform when the job completes option, check Page. 

9. In the Page drop-down list, select Palle Petersen.  

10. In the Page actions drop-down list, select When the job fails, and click OK. 

11. In Object Explorer, right-click Job that Succeeds and click Properties. 

12. In the Select a page pane, click Notifications. 

13. In the Actions to perform when the job completes option, check Page. 

14. In the Page drop-down list, select Palle Petersen.  

15. In the Page actions drop-down list, select When the job fails, and click OK. 

16. In Object Explorer, right-click Backup Log TestAlertDB and click Start Job at Step. 

17. In the Start Jobs - Proseware window, click Close. 

18. In Object Explorer, right-click Job That Fails, and click Start Job at Step. 

19. In the Start Jobs - Proseware window, note that the job failed and click Close. 

20. In Object Explorer, right-click Job That Succeeds and click Start Job at Step. 

21. In the Start Jobs - Proseware window, click Close. 

22. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

23. Review the T-SQL script. 

24. On the Toolbar click Execute. 

Note Two additional emails should now appear in the list, an email from the backup job 
sent to Jeff Hay and an email from the job that fails sent to Palle Petersen. No email 
should be sent for the job called “Job That Succeeds”. 

Challenge Exercise 3: Implement Alerts (Only if time permits) 

  Task 1: Configure and Test Alerts 

1. Review the supporting documentation for the alerting requirements. 

2. In Object Explorer, right-click Alerts and click New Alert.  

3. In the New Alert window, in the Name textbox, type Error Severity 17 Alert. 

4. In the Severity drop-down list, click 017 – Insufficient Resources. 

5. In the Select a page pane, click Response. 

6. Check Notify operators, check all checkboxes in the Pager column and click OK. 

7. In Object Explorer, right-click Alerts and click New Alert.  
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8. In the New Alert window, in the Name textbox, type Error Severity 18 Alert. 

9. In the Severity drop-down list, click 018 – Nonfatal Internal Error. 

10. In the Select a page pane, click Response. 

11. Check Notify operators, check all checkboxes in the Pager column and click OK. 

12. In Object Explorer, right-click Alerts and click New Alert.  

13. In the New Alert window, in the Name textbox, type Transaction Log Full Alert. 

14. Click the Error number option, and in the Error number textbox type 9002. 

15. In the Select a page pane, click Response. 

16. Check Notify operators, check all checkboxes in the Pager column and click OK. 

17. In Solution Explorer, double-click the file 71 – Lab Exercise 3.sql to open it. 

18. Review the T-SQL script. 

19. On the Toolbar click Execute. 

Note Executing this script will result in an error, indicating message 9002. 

20. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

21. Review the T-SQL script. 

22. On the Toolbar click Execute. 

Note Additional emails should be listed related to the SQL Server alert system. 
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Lab 16: Performing Ongoing Database 
Maintenance 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_16_PRJ\10775A_16_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Check Database Integrity Using DBCC CHECKDB 

  Task 1: Check the consistency of the databases on the Proseware instance 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1a.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Note Errors will be returned from the CoreAdmin database. 

  Task 2: Correct any issues found 

1. In Solution Explorer, double-click the file 52 – Lab Exercise 1b.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Note Errors will be returned from the CoreAdmin database during this process. 
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Exercise 2: Correct Index Fragmentation 

  Task 1: Review the fragmentation of indexes in the MarketDev database to determine 
which indexes should be defragmented and which indexes should be rebuilt 

1. In Solution Explorer, double-click the file 61 – Lab Exercise 2a.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

  Task 2: Defragment indexes as determined 

1. In Solution Explorer, double-click the file 62 – Lab Exercise 2b.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

  Task 3: Rebuild indexes as determined 

1. In Solution Explorer, double-click the file 63 – Lab Exercise 2c.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Exercise 3: Create a Database Maintenance Plan 

  Task 1: Create the required database maintenance plan 

1. In Object Explorer, expand Proseware, expand Management, right-click Maintenance Plans, and 
click Maintenance Plan Wizard. 

2. In the Maintenance Plan Wizard window, click Next.  

3. In the Select Plan Properties window, in the Name textbox, type Proseware Weekly Maintenance. 
Note the available scheduling options and click Change.  

4. In the New Job Schedule window, in the Name textbox, type 6PM Every Sunday.  

5. In the Occurs once at textbox, change the time to 6PM, and click OK.  

6. In the Select Plan Properties window, click Next. 

7. Review the available options and check Rebuild index and Check Database Integrity, and then 
click Next.  

8. In the Select Maintenance Task Order window, click Next.  

9. In the Define Database Check Integrity Task window, from the Databases drop-down list, select All 
databases, and click OK then click Next. 

10. In the Define Rebuild Index Task window, from the Databases drop-down list, check the 
MarketDev database, and click OK.  

11. In the Free space options, click Change free space per page to:.  

12. In the Change free space per page to: textbox, type 10. 
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13. Check Keep index online while reindexing, and click Next. 

14. In the Select Report Options window, in the folder location textbox, type L:\MKTG, and click 
Next.  

15. In the Complete the Wizard window, click Finish.  

16. In the Maintenance Plan Wizard Progress window, click Close. 

Challenge Exercise 4: Investigate Table Lock Performance (Only if time 
permits) 

  Task 1: Execute DBCC CHECKDB using database snapshots 

1. In Solution Explorer, double-click the file 81 – Lab Exercise 4a.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Note Note the time taken to execute. A typical duration would be 42 seconds. 

  Task 2: Execute DBCC CHECKDB using table locks 

1. In Solution Explorer, double-click the file 82 – Lab Exercise 4b.sql to open it. 

2. Review the T-SQL script. 

3. On the Toolbar click Execute. 

Note Note the time taken to execute. A typical duration would be 7 seconds. 
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Lab 17: Tracing Access to SQL Server 2012 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_17_PRJ\10775A_17_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Capture a Trace Using SQL Server Profiler 

  Task 1: Create and start a suitable SQL Server Profiler trace 

1. In Microsoft SQL Server Management Studio, on the Tools menu, click SQL Server Profiler.  

2. In the Connect to Server window, click Connect.  

3. In the Trace name, type Proseware Trace.  

4. In the Use the template drop-down, select Tuning. 

5. Check the Save to file option. 

6. In the Save As window, navigate to the desktop, and click Save.  

7. Uncheck the Enable file rollover option. 

8. Change the Set maximum file size (MB) option to 500.  

9. Click the Events Selection tab. Note the selected events. 

10. Click on the Database Name column heading to create a filter. 

11. Expand the Like node and enter MarketDev and click OK.  

12. In the Trace Properties window, click Run. 

13. From the Window menu, uncheck Auto scroll. 
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  Task 2: Execute the workload 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

2. Review the T-SQL script. 

3. From the Query menu, select Query Options.  

4. In the Query Options window, click Grid. In the Grid options, check Discard results after 
execution.  

5. Click OK to close the Query Options window. 

6. On the Toolbar click Execute. 

7. Wait for the query to complete.  

Note The query is complete when Query executed successfully appears below the 
Messages tab. No output messages will be seen. 

  Task 3: Stop the trace 

• In SQL Server Profiler, on the Toolbar, click the Stop Selected Trace icon, and close SQL Server 
Profiler. 

Exercise 2: Analyze a Trace Using Database Engine Tuning Advisor 

  Task 1: Analyze the captured trace in Database Engine Tuning Advisor 

1. In Microsoft SQL Server Management Studio, from the Tools menu, click Database Engine Tuning 
Advisor.  

2. In the Connect to Server window, click Connect.  

3. Maximize the Database Engine Tuning Advisor window. 

4. In the Workload group box, ensure that File is selected, and click the Browse for a Workload File 
button. 

5. Browse to the Desktop folder, select the Proseware Trace.trc file and click Open.  

6. In the Database for workload analysis drop-down, select MarketDev.  

7. In the Select databases and tables to tune list, check the MarketDev database. 

8. From the Toolbar, click the Start Analysis button to start the tuning analysis. 

  Task 2: Review the suggested modifications 

1. Observe the tuning progress and when the analysis is complete, note the recommendations. The 
exact recommendations will vary but it is likely you will see both index and statistics 
recommendations. 

2. Scroll the recommendations output to the right and note the hyperlinks to sample code. 

3. Click each of the recommendations in turn and note the suggested index or statistics structures. 

4. Close Database Engine Tuning Advisor. 
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Challenge Exercise 3: Configure SQL Trace (Only if time permits) 

  Task 1: Create a script that uses SQL Trace procedures to implement the same type of 
capture as you performed in Exercise 1 but with a different trace name 

1. In Microsoft SQL Server Management Studio, from the Tools menu, click SQL Server Profiler. 

2. In the Connect to Server window, click Connect.  

3. In the Trace name, type ProsewareTrace2.  

4. In the Use the template drop-down, select Tuning. 

5. Check the Save to file option. 

6. In the Save As window, navigate to the desktop, and click Save.  

7. Uncheck the Enable file rollover option. 

8. Change the Set maximum file size (MB) option to 500.  

9. Click the Events Selection tab. Note the selected events. 

10. Click on the Database Name column heading to create a filter. 

11. Expand the Like node and enter MarketDev and click OK.  

12. In the Trace Properties window, click Run. 

13. From the Toolbar, click the Stop Selected Trace icon. 

14. From the File menu, click Export, click Script Trace Definition, click For SQL Server 2005 – 
SQL11. 

15. Navigate to the Desktop and in the File name text box, type ProsewareTrace2 and click Save. 

16. In the SQL Server Profiler window, click OK. 

17. Close SQL Server Profiler. 

  Task 2: Test that the script works as expected by using the same workload 

1. In Solution Explorer, from the File menu, click Open, click File. 

2. In the Open File window, navigate to the Desktop, click Proseware Trace2.sql and click Open. 

3. In the first row that begins with an exec command, change the string InsertFileNameHere to 
D:\MKTG\ProsewareTrace2. 

4. On the Toolbar click Execute to start the trace. 

Note Record the Trace ID value that is returned. 

5. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

6. Review the T-SQL script. 

7. From the Query menu, select Query Options.  

8. In the Query Options window, click Grid. In the Grid options, check Discard results after 
execution.  
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9. Click OK to close the Query Options window. 

10. On the Toolbar click Execute. 

11. Wait for the query to complete.  

Note The query is complete when Query executed successfully appears below the 
Messages tab. No output messages will be seen. 

12. In Solution Explorer, double-click the file 71 – Lab Exercise 3.sql to open it. 

13. Review the T-SQL script and replace the value of the @TraceID variable with the value you 
recorded earlier in this task. 

14. On the Toolbar click Execute. 

  Task 3: Analyze the new captured output and note if the suggested changes are 
identical to those suggested in Exercise 2 

1. In Microsoft SQL Server Management Studio, from the Tools menu, click Database Engine Tuning 
Advisor.  

2. In the Connect to Server window, click Connect.  

3. Maximize the Database Engine Tuning Advisor window. 

4. In the Workload group box, ensure that File is selected, and click the Browse for a Workload File 
button. 

5. Browse to the D:\MKTG folder, select the ProsewareTrace2.trc file and click Open.  

6. In the Database for workload analysis drop-down, select MarketDev.  

7. In the Select databases and tables to tune list, check the MarketDev database. 

8. From the Toolbar, click the Start Analysis button to start the tuning analysis. 

9. When the analysis is complete, compare the results to the results you saw earlier in Exercise 2.  

Note The results should be identical. 
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Lab 18: Monitoring SQL Server 2012 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_18_PRJ\10775A_18_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Investigating DMVs 

  Task 1: Investigate the use of Dynamic Management Views and Functions 

1. In Solution Explorer, double-click the file 51 – Lab Exercise 1.sql to open it. 

2. Follow the instructions in the T-SQL script. 

Exercise 2: Configure Management Data Warehouse 

  Task 1: Create a management data warehouse for central collection of performance 
data 

1. In Object Explorer, expand the Proseware server, expand Management, right-click Data 
Collection, and click Configure Management Data Warehouse.  

2. In the Configure Management Data Warehouse Wizard window, click Next.  

3. In the Select Configuration task window, click Next.  

4. In the Configure Management Data Warehouse Storage window, in the Server name textbox 
ensure Proseware has been entered, and click New.  

5. In the New Database window, in the Database name textbox, type MDW, and click OK.  

6.  In the Configure Management Data Warehouse Storage window, click Next.  

7. In the Map Logins and Users window, review the options and click Next.  

8. In the Complete the Wizard window, click Finish.  

9. In the Configure Data Collection Wizard Progress window, click Close. 
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Exercise 3: Configure Instances for Data Collection 

  Task 1: Configure data collection on each instance 

1. In Object Explorer, expand the Proseware server, expand Management, right-click Data 
Collection, and click Configure Management Data Warehouse.  

2. In the Configure Management Data Warehouse Wizard window, click Next.  

3. In the Select Configuration task window, click Set up data collection, and click Next.  

4. In the Configure Management Data Warehouse Storage window, click the ellipsis button beside 
the Server name textbox.  

5. In the Connect to Server window, in the Server name textbox, type Proseware, and click Connect.  

6. In the Database name drop-down list, select MDW, and click Next.  

7. In the Complete the Wizard window, click Finish.  

8. In the Configure Data Collection Wizard Progress window, click Close. 

9. In Object Explorer, click Connect, then click Database Engine. In the Connect to Server window, in 
the Server name textbox type AdventureWorks, and click Connect. 

10. In Object Explorer, expand the AdventureWorks server, expand Management, right-click Data 
Collection, and click Configure Management Data Warehouse.  

11. In the Configure Management Data Warehouse Wizard window, click Next.  

12. In the Select Configuration task window, click Set up data collection, and click Next.  

13. In the Configure Management Data Warehouse Storage window, click the ellipsis button beside 
the Server name textbox.  

14. In the Connect to Server window, in the Server name textbox, type Proseware, and click Connect.  

15. In the Database name drop-down list, select MDW, and click Next.  

16. In the Complete the Wizard window, click Finish.  

17. In the Configure Data Collection Wizard Progress window, click Close. 

Challenge Exercise 4: Work with Data Collector Reports (Only if time 
permits) 

  Task 1: Disable data collectors on both instances 

1. In Object Explorer, expand the Proseware server, expand Management, right-click Data 
Collection, and click Disable Data Collection. If a confirmation window appears, click Close. 

2. In Object Explorer, expand the AdventureWorks server, expand Management, right-click Data 
Collection, and click Disable Data Collection. If a confirmation window appears, click Close. 
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  Task 2: Restore a backup of the MDW database 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click the MDW 
database and click Delete. 

2. In the Delete Object window, check the Close existing connections checkbox and click OK. 

3. In Object Explorer, expand the Proseware server, right-click Databases, and click Restore 
Database. 

4. In the Restore Database window, in the Source options click Device.  

5. Click the ellipsis beside the Device textbox.  

6. In the Select backup devices window, click Add. 

7. Navigate to the file D:\10775A_Labs\10775A_18_PRJ\10775A_18_PRJ\MDW.bak and click OK. 

8. In the Select backup devices window, click OK. 

9. In the Select a page pane, click Options. 

10. In the Restore options, check Overwrite the existing database (WITH REPLACE), and click OK. 

11. In the Microsoft SQL Server Management Studio window, click OK. 

  Task 3: Review the available reports 

1. In Object Explorer, expand Proseware server, expand Databases.  

2. Right-click the MDW database, click Reports, click Management Data Warehouse, and click 
Management Data Warehouse overview. 

3. Review the Disk Usage Report for MIA-SQL1\MKTG. 

4. Close the report window. 

5. Right-click the MDW database, click Reports, click Management Data Warehouse, and click 
Management Data Warehouse overview. 

6. Review the Server Activity Report for MIA-SQL1\MKTG. 

7. Close the report window. Right-click the MDW database, click Reports, click Management Data 
Warehouse, and click Management Data Warehouse overview. 

8. Review the Query Statistics Report for MIA-SQL1\MKTG. 

9. Close the report window. 
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Module 19: Managing Multiple Servers  

Lab 19: Managing Multiple Servers 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_19_PRJ\10775A_19_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercise 1: Configure CMS and Execute Multi-server Queries 

  Task 1: Create a central management server 

1. From the View menu in SQL Server Management Studio, click Registered Servers. 

2. In the Registered Servers window that opens, expand Database Engine.  

3. Right-click Central Management Servers, and click Register Central Management Server.  

4. In the New Server Registration window, in the Server name textbox, type Proseware and click 
Save. 

  Task 2: Create a server group within the CMS 

1. In SQL Server Management Studio, in Registered Servers, expand Central Management Servers.  

2. Right-click Proseware and click New Server Group.  

3. In the New Server Group Properties window, in the Group name textbox, type Core Servers and 
click OK. 

4. In Registered Servers, right-click Core Servers and click New Server Registration.  

5. In the New Server Registration window, in the Server name textbox, type Proseware and click 
Save. 

6. In Registered Servers, right-click Core Servers and click New Server Registration.  

7. In the New Server Registration window, in the Server name textbox, type AdventureWorks and 
click Save. 
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  Task 3: Execute a command to find all databases on any core server in full recovery 
model 

1. In Registered Servers, right-click Core Servers and click New Query.  

2. Type the following code into the new query window: 

SELECT * FROM sys.databases WHERE recovery_model_desc = ‘FULL’; 

3. From the Toolbar, click Execute. 

Note A list of databases in full recovery model is returned. 

Exercise 2: Deploy a Data-tier Application 

  Task 1: Deploy the data-tier application using SSMS 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click Databases, and 
click Deploy Data-tier Application.  

2. In the Introduction window, click Next. 

3. In the Select Package window, enter or select the path D:\10775A_Labs\10775A_19_PRJ 
\10775A_19_PRJ\CityCode.dacpac, and click Next. 

4. In the Update Configuration window, click Next. 

5. In the Summary window, click Next. 

6. In the Deploy DAC window, click Finish. 

7. In Solution Explorer, double-click the file 61 – Lab Exercise 2.sql to open it. 

8. Review the T-SQL script. 

9. On the Toolbar click Execute. 

Exercise 3: Register and extract a data-tier application 

  Task 1: Register the existing database as a data-tier application 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click the Research 
database, click Tasks, and click Register as Data-tier Application. 

2. In the Introduction window, click Next. 

3. In the Set Properties window, click Next. 

4. In the Validation and Summary window, click Next. 

5. In the Register DAC window, click Finish. 

  Task 2: Extract a dacpac from the database to send to the development team 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click the Research 
database, click Tasks, and click Extract Data-tier Application. 
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2. In the Introduction window, click Next. 

3. In the Set Properties window, in the Save to DAC package file textbox, type 
D:\MKTG\Research.dacpac, and then click Next. 

4. In the Validation and Summary window, click Next. 

5. In the Build Package window, click Finish. 

Challenge Exercise 4: Upgrade a Data-tier Application (Only if time 
permits) 

  Task 1: Attempt to deploy the v2 upgrade 
1. In Object Explorer, expand the Proseware server, right-click Databases and click Refresh. 

2. Expand Databases, right-click the CityCode database, click Tasks, and click Upgrade Data-tier 
Application. 

3. In the Introduction window, click Next. 

4. In the Select Package window, enter or select the path D:\10775A_Labs\10775A_19_PRJ 
\10775A_19_PRJ\CityCode_v2.dacpac, and click Next. 

5. In the Detect Change window, click Next. 

6. In the Options window, uncheck the Execute pre-deployment Script, check Rollback on failure 
and click Next. 

7. In the Review Upgrade Plan window, check Proceed despite possible data loss and click Next. 

8. In the Summary window, click Next. 

9. In the Microsoft SQL Server Management Studio window, click OK. 

10. In the Upgrade DAC window, notice the failures and click Finish. 

11. In Object Explorer, right-click Databases, and click Refresh. 

Note All databases and data-tier applications have been left unchanged. 

  Task 2: Deploy the v3 upgrade 
1. In Object Explorer, expand Databases, right-click the CityCode database, click Tasks, and click 

Upgrade Data-tier Application. 

2. In the Introduction window, click Next. 

3. In the Select Package window, enter or select the path D:\10775A_Labs\10775A_19_PRJ 
\10775A_19_PRJ\CityCode_v3.dacpac, and click Next. 

4. In the Detect Change window, click Next. 

5. In the Options window, check Rollback on failure and click Next. 

6. In the Review Upgrade Plan window, click Next. 

7. In the Summary window, click Next. 

8. In the Upgrade DAC window, click Finish. 

9. In Object Explorer, right-click Databases, and click Refresh. 

Note The data-tier application is upgraded. 
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Module 20: Troubleshooting Common SQL Server 2012 
Administrative Issues  

Lab 20: Troubleshooting Common Issues 
Lab Setup 
For this lab, you will use the available virtual machine environment. Before you begin the lab, you must 
complete the following steps: 

1. Revert the virtual machines as per the instructions in D:\10775A_Labs\Revert.txt. 

2. In the virtual machine, click Start, click All Programs, click Microsoft SQL Server 2012, and click 
SQL Server Management Studio. 

3. In the Connect to Server window, type Proseware in the Server name text box. 

4. In the Authentication drop-down list box, select Windows Authentication and click Connect. 

5. In the File menu, click Open, and click Project/Solution. 

6. In the Open Project window, open the project 
D:\10775A_Labs\10775A_20_PRJ\10775A_20_PRJ.ssmssln. 

7. In Solution Explorer, double-click the query 00-Setup.sql. When the query window opens, click 
Execute on the toolbar. 

Exercises 1 – 5: Troubleshoot and Resolve SQL Server Administrative 
Issues 

Exercise 1 – Issue 1 

  Task 1: Read the supporting documentation for the exercise 

• Read the supporting documentation for the exercise. 

  Task 2: Troubleshoot and resolve the issue 

1. In Object Explorer, expand the Proseware server, expand Security, and expand Logins.  

2. Beside the PromoteApp user, note the icon with a red down arrow, the login is disabled.  

3. Right-click PromoteApp, and click Properties. 

4. In the Select a page pane, click Status, click Enabled, and click OK. 

5. In Object Explorer, right-click Logins, and click Refresh. Note that the login is now enabled. 
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Exercise 2 – Issue 2 

  Task 1: Read the supporting documentation for the exercise 

• Read the supporting documentation for the exercise. 

  Task 2: Troubleshoot and resolve the issue 

1. In Object Explorer, expand the Proseware server, expand Databases, and note the status of the 
AdminDB database. The database is in a restoring state, the junior DBA may have performed a tail-
log backup. 

2. In Object Explorer, right-click the AdminDB database, click Tasks, click Restore, and click 
Transaction Log.  

3. In the Restore Transaction Log – AdminDB window, click From file or tape, and click OK. 

4. In the Microsoft SQL Server Management Studio window, click OK. 

Exercise 3 – Issue 2 

  Task 1: Read the supporting documentation for the exercise 

• Read the supporting documentation for the exercise. 

  Task 2: Troubleshoot and resolve the issue 

1. In Object Explorer, expand the Proseware server, expand SQL Server Agent, and expand Jobs. 

2. Right-click the Get File List job, and click Start Job at Step. 

3. In the Start Jobs – Proseware window, note the failure, and click Close. 

4. In Object Explorer, right-click the Get File List job, and click View History. 

5. In the Log File Viewer – Proseware window, click on the plus sign in a failing row to expand the job 
steps. 

6. Click on the row for Step ID 1. 

7. In the Selected row details pane, scroll down to find the error (Logon failure: unknown user name 
or bad password). Note when using the proxy for David.Alexander. 

8. In the Log File Viewer - Proseware window, click Close. 

9. In Object Explorer, expand Security, expand Credentials, right-click DavidAlexanderCredential, 
and click Properties. 

10. In the Credential Properties - DavidAlexanderCredential window, in the Password textbox, and the 
Confirm password textbox, type Pa$$w0rd, and click OK. 

11. In Object Explorer, right-click the Get File List job, and click Start Job at Step. 

12. In the Start Jobs - Proseware window, note that the job still fails, and click Close. 

13. In Object Explorer, right-click the Get File List job, and click View History. 

14. In the Log File Viewer - Proseware window, click on the plus sign in a failing row to expand the job 
steps. 

15. Click on the row for Step ID 1. 
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16. In the Selected row details pane, scroll down to find the error (Access is denied).  

17. In the Log File Viewer - Proseware window, click Close. We need to investigate the job step to see 
why an Access is denied error could be returned. 

18. In Object Explorer, right-click the Get File List job, and click Properties. 

19. In the Select a page pane, click Steps, then click Edit. 

20. Note that the command being executed requires permission to read the directory entries in the 
D:\MKTG folder and permission to write to the L:\MKTG folder using the identity of David 
Alexander. 

21. Click Cancel and then click Cancel. 

22. On the basis that write permissions are less likely to be granted than read permissions, we will 
investigate the write permissions first. In Windows Explorer, right-click folder L:\MKTG and click 
Properties. 

23. In the MKTG Properties window, click the Security tab and note that David Alexander has no access 
to the folder, nor do any groups that he is likely to be a member of. 

24. Click Edit then in the Permissions for MKTG window, click Add. 

25. Ensure that the value of From this location is set to AdventureWorks.msft, then in the Enter the 
object names to select textbox, type David.Alexander and click OK. 

26. In the Permissions for MKTG window, click the Allow checkbox in the Modify row and click OK. 

27. In the MKTG Properties window, click OK. 

28. Now we will test if the job runs.  

29. In Object Explorer, right-click the Get File List job, and click Start Job at Step. 

30. In the Start Jobs - Proseware window, note that the job still fails, and click Close. 

31. Now we need to check the read permissions. 

32. In Windows Explorer, right-click folder D:\MKTG and click Properties. 

33. In the MKTG Properties window, click the Security tab and note that David Alexander has no access 
to the folder, nor do any groups that he is likely to be a member of. 

34. Click Edit then in the Permissions for MKTG window, click Add. 

35. Ensure that the value of From this location is set to AdventureWorks.msft, then in the Enter the 
object names to select textbox, type David.Alexander and click OK. 

36. In the Permissions for MKTG window, click OK. 

37. In the MKTG Properties window, click OK. 

38. Now we will test again whether or not the job runs.  

39. In Object Explorer, right-click the Get File List job, and click Start Job at Step. 

40. In the Start Jobs - Proseware window, note that the job now works, and click Close. 
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Exercise 4 – Issue 2 

  Task 1: Read the supporting documentation for the exercise 

• Read the supporting documentation for the exercise. 

  Task 2: Troubleshoot and resolve the issue 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click AdminDB 
database, and click Properties.  

2. In the Select a page pane, click Options. 

3. Review the options related to statistics. 

4. Change the Auto Create Statistics to True. 

5. Change the Auto Update Statistics to True, and click OK. 

Note The following steps cause statistics to be updated immediately rather than waiting 
for autostats to correct the situation. 

6. In Object Explorer, right-click AdminDB, and click New Query. 

7. In the Query window, type the following command: 

EXEC sp_updatestats; 

8. On the Toolbar, click Execute. 

Exercise 5 – Issue 2 

  Task 1: Read the supporting documentation for the exercise 

• Read the supporting documentation for the exercise. 

  Task 2: Troubleshoot and resolve the issue 

1. In Object Explorer, expand the Proseware server, expand Databases, right-click CityDetails 
database, and click Properties.  

2. In the Select a page pane, click Options. 

3. Review the options related to statistics. 

4. Change the Auto Close option to False and click OK. 
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